
 

 

Writing for SQA 
(A to Z version) 

About this guide 
Writing for SQA is for everyone in the organisation. Whether you are writing an 
email, a report, an assessment item, or a web page — this guide is for you. 
 
The topics in the list on the next page are hyperlinks to explanations and 
examples that we hope you will find helpful. Most of the topics are no more than 
half a page in length but some extend to a few pages. If you can’t find an entry 
for a particular topic, try using the Find function in the PDF version of this guide. 
 
If you are new to SQA or are using Writing for SQA for the first time, we 
recommend that you start with: 
 
♦ Writing the name of the organisation 
♦ Referring to SQA’s qualifications 
♦ Plain English 
 
If you have any questions, please email marketing@sqa.org.uk or contact one of 
SQA’s editors. 
[Go to A to Z content ...] 
  

mailto:marketing@sqa.org.uk


 

This 2022 version of Writing for SQA includes: 
 
♦ updated guidance on accessible and inclusive writing, including guidance on 

tables and supporting autistic people 
♦ advice on use of ampersands 
♦ guidance on setting up your email signature 
♦ guidance on page numbering in SQA documents 
♦ how we should refer to Next Generation Higher National Qualifications in 

SQA documents  
♦ additions to the preferred spelling checklist 
♦ guidance on nested headings 
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A or an? 
Be guided by pronunciation. Use ‘a’ before words beginning with ‘h’, unless the 
‘h’ is silent: 
 
♦ a history, a hope, a Higher pass, a hotel 
♦ an hour, an heir, an honours degree 
 

Before abbreviations 
Where the letters are sounded as letters, use ‘an’ before A, E, F, H, I, L, M, N, O, 
R, S, and X: 
 
♦ an HNC, an HND, an SVQ, an SQA-approved centre 
[Back] 
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Abbreviations and acronyms (initialisms) 
Initialisms can be useful but too many of them in a document can make your 
writing hard to follow. Be consistent in the way you use abbreviations — for 
example, does ‘IV’ mean internal verifier or internal verification? 
 
Avoid overusing abbreviations — they can make text harder to read for someone 
who is in a hurry or for someone who is not familiar with our shorthand. 
 
When giving a name that is normally abbreviated to its initials give it in full the 
first time you use it, followed by the abbreviated form in parentheses (but not in a 
heading). For example: 
 
‘Highlands and Islands Enterprise (HIE) is responsible for economic regeneration 
in that region. HIE’s role also extends to …’ 
 
An acronym is an abbreviation that can be pronounced as a word, for example 
scuba (self-contained underwater breathing apparatus) or NATO (North Atlantic 
Treaty Organization). 
 

Full stops 
Full stops mark the ends of sentences. We do not use them in abbreviations or 
acronyms: 
 
♦ BBC, IBM, HIE, UHI, Mr Blair, Dr Foster 
 
See Eg, ie, etc for more on abbreviations. 
 
[Back] 
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Accessible and inclusive writing 
SQA communications, publications and everything else we write (content) should 
be accessible to everyone and should be written in language that is inclusive. 
 
By ‘accessible’ we mean being able to physically access our content and being 
able to understand it. By ‘inclusive language’ we mean language that does not 
exclude anyone because of disability, race, nationality, ethnicity, religion, gender 
identity, or sexual orientation. While we should all make every effort to write 
inclusively, writers and editors should also ensure that this does not affect any 
technical requirements of our qualifications. 
 
When speaking to an audience, you can often recognise when someone isn’t 
understanding something, and so you can modify or repeat what you are saying. 
However, if someone reads your text but can’t understand it, then your message 
doesn’t get across. 

Writing for everyone 
Over one in four adults in Scotland experience challenges due to a lack of literacy 
skills.1 They can understand short, straightforward texts on familiar topics 
accurately and independently, and obtain information from everyday sources, but 
reading information from unfamiliar sources, or on unfamiliar topics, can cause 
problems. 
 

Here are some things to look out for: 
Sentence structure 
Keep sentences short and uncomplicated. As far as possible, stick to a limit of 
one idea or instruction in each sentence. As a general rule, the more complex the 
information, the simpler the sentence structure should be. 
 

Emphasis 
Emphasising important words in bold type can help to clarify an instruction. 
However, this can become distracting if not used with care. It should be used 
consistently and should only be used when it is clearly helpful. You should avoid 
the use of italics wherever possible as it can be harder to read than roman text. 
Bold and italic emphasis will not be picked up by screen readers. 
 

Consistency 
If you need to use the same name, phrase or description more than once, be 
consistent and use the same phrasing or emphasis each time. Using different 
words to describe the same thing, or using different emphasis on the same word, 
may confuse some readers. 

 
1 Adult Literacies in Scotland 2020: Strategic guidance 

https://www.gov.scot/publications/adult-literacies-scotland-2020-strategic-guidance/pages/3/
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Using SQA Normal 
We recommend that you use the SQA Normal template to structure your 
documents. This will provide a consistent structure and make sure that your font, 
spacing and bullet points are accessible.  
 

Font  
For normal text, using arial font will make your document easier to read on 
screen and scale large or small quite well. For maximum readability, you should 
use a minimum font size of 11pt. 
 

Bullet points 
Sometimes the best way to present information is in a bulleted list. We suggest 
that you introduce a list with a lead-in phrase or clause followed by a colon, like 
this: 
 
Bullet-point lists are: 
 
♦ easy to read 
♦ visually striking 
♦ clean and neat 
 

Tables 
If you can navigate all the way through a table using only the Tab key, it should 
be screen reader accessible.  

Some points to bear in mind when creating tables in Word are: 

♦ avoid nested tables 
♦ avoid cells that are split, merged or empty 
♦ don’t let rows break across pages 
♦ if a table spans more than one page, repeat the header row 
♦ try to keep your table as simple as possible 
♦ your table should read from left to right 
 

And here are some things to avoid: 
The passive voice 
Minimise use of the passive voice. The active form is easier to understand. 
 

Verb and/or adverb forms of the equivalent noun forms 
Use verb forms rather than the equivalent (but longer) noun forms. For example: 
‘protect’ is easier than ‘protection’, ‘absorb’ is easier than ‘absorption’ and so on. 
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Ambiguity 
Avoid ambiguity — it can be a problem for someone with reading difficulties. Try 
asking a colleague to check if your meaning is clear. 
 

Metaphors, idioms and jargon 
Avoid metaphors, idiom and jargon wherever possible. 

 
A metaphor is a word or phrase that says one thing is another thing, but it isn’t 
literally true, for example ‘It is raining cats and dogs’. An idiom is a word or 
phrase that has informally developed a specific meaning, for example ‘off the cuff’ 
and ‘jump the gun’. Jargon is a special way to use words that is shared only by a 
certain group of people. Using jargon is often shorter than explaining ourselves, 
but it can also prevent others from joining in or understanding, for example: ‘this 
candidate has been resulted’. 

 
Many of the above suggestions share common ground with plain English. 

Supporting disabled people 
People who are disabled face barriers on an everyday basis. This includes 
prejudice, negative stereotyping, lack of accessible transport, housing and 
information — and a lack of understanding of their needs and rights. 
Language can reinforce either positive or negative views of disability and can be 
linked to the two models of disability. 
 
The medical model is the traditional view of disability and sees someone’s 
impairment as the problem. For example, ‘the candidate is wheel-chair bound 
and so cannot use the steps to access the centre’. 
 
The social model sees disability as barriers that people experience. For 
example, ‘the centre doesn’t have a lift or ramp and so isn’t suitable for a 
candidate who is a wheel-chair user’.  
 
The social model also focuses on the language used when discussing disability 
and the impact that can have on attitudes. For example, ‘the candidate is a 
wheel-chair user’ is more positive than the ‘candidate is wheel-chair bound’. 
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SQA favours the social model of disability. So … 
 

Do say… Don’t say… 
disabled candidates* the disabled or candidates with 

disabilities 
people living with deafness people suffering from deafness 
non-disabled able-bodied 
has epilepsy suffers from epilepsy 
people with visual impairments; blind 
people; blind and partially sighted 
people 

the blind 

person with a mental health condition mental patient 
 
*‘Disabled people’ is the preferred term rather than ‘people with disabilities’ 
because it is based on the idea that disability stems from the barriers they face. 
Disability is an area where language is subject to debate and change. There is 
often concern as to whether words used are appropriate. Since language is 
constantly evolving the following is only a guide to what is preferred. It is 
important to remember that people have the right and choice to describe 
themselves as they wish. 
 
See Introduction to the Social and Medical Models of Disability from 
www.ombudsman.org.uk for more on this topic. 
 

Ways to help readers who are living with a disability 
Offer alternatives 
Can you think of any barriers that might restrict your readers from carrying out a 
task or activity? For example, a task asking an IT candidate to use a mouse to 
carry out an action causes problems for someone with motor difficulties. Give 
alternative ways to carry out the task such as using the keyboard. 
SQA can produce material in audio, braille and other alternative formats for 
customers who are unable to access the standard formats (see the assessment 
arrangements pages of SQA’s website). When a braille question paper is 
requested for the exam diet we publish it on our website afterwards as a past 
paper. 
 

Be aware that your reader may be using a screen reader 
Screen readers were invented to help people with visual loss but they are often 
used for supportive reading where a learner tries to read the text on-screen at the 
same time. 
 
JAWs is an example of a screen reader used by those with severe visual 
impairment, but note that the Scottish Voice offers a text reader with voices in a 
Scottish accent. 
 

https://www.ombudsman.org.uk/sites/default/files/FDN-218144_Introduction_to_the_Social_and_Medical_Models_of_Disability.pdf
http://www.ombudsman.org.uk/
https://www.sqa.org.uk/sqa/14976.779.html
https://www.sqa.org.uk/sqa/14976.779.html
http://www.freedomscientific.com/Products/software/JAWS/
https://www.thescottishvoice.org.uk/home/
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Pictures 
Only use images that complement the written text. Try not to rely solely on 
pictures to explain a particular point — someone using a screen reader could be 
disadvantaged. You must give any images a visual description as alternative text. 
In Word, right-click (if using a mouse) on your picture and choose ‘Format 
Picture’, then go to the tab called ‘Layout & Properties’ and enter the description 
under ‘Alt Text’. 
 
You should not exclusively use images as a navigation device, or to convey 
information. If you use images, you should also provide a text equivalent. 
 

Colour 
People with a visual stress issue can find that the use of coloured glasses, 
overlays or paper can improve reading fluency, comfort, comprehension, 
attention and concentration. However, someone using colour in this way could 
run into problems if colour is used in the original document. One solution is to 
include a numerical key together with colour. 
 
Similarly, people who are colour-blind may need support in accessing a 
document that includes these red or green colours. 
 
Be aware also that any meaning that colour is used to convey could be 
inadvertently lost if a document is printed in black and white. 
 

Use Word styles 
Use the ‘Styles’ function to apply heading styles in Microsoft Word. This will make 
the text accessible to someone using a screen reader. 
How to use Word styles 
 

Phrases to avoid 
Never use ‘click here’ if you are supplying text for a web page. In fact, you should 
avoid using the word ‘click’ in general, as it assumes the reader is using a mouse 
to navigate the site. The same goes for phrases like ‘use the box on the right’ — 
screen readers and some specially configured browsers do not present content in 
columns, so the statement would not make sense to the person reading or 
hearing it. 
 
Instead of ‘click here’, try to make your link text meaningful. For example: 
 
‘You can find more on inclusive language on the UK Government website Gov.uk’ 
or ‘See Gov.uk for more on inclusive language.’ 
 

Guidelines for web accessibility 
SQA’s website, and all our web services, follow the W3 Consortium guidelines for 
web accessibility, aiming for ‘AA’ standard. 
W3.org web accessibility quick reference guide 
SQA’s website accessibility page 

http://www.docs.is.ed.ac.uk/skills/documents/3812/3812.pdf
https://www.gov.uk/government/publications/inclusive-communication/inclusive-language-words-to-use-and-avoid-when-writing-about-disability
https://www.gov.uk/government/publications/inclusive-communication/inclusive-language-words-to-use-and-avoid-when-writing-about-disability
http://www.w3.org/
http://www.w3.org/
http://www.w3.org/WAI/WCAG21/quickref/?versions=2.0
https://www.sqa.org.uk/sqa/4380.html
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Supporting autistic people 
Although a ‘person-first’ description is often seen as best practice, many autistic 
people prefer to be described as an ‘autistic person’, rather than a ‘person with 
autism’. Surveys around the topic substantiate this view, including recent 
research (March 2022) that states that over 75 per cent of autistic people prefer 
this term. We recommend using this ‘identity-first’ approach when describing 
autistic people in your writing for SQA. 
 

Supporting people who are from different cultures or 
whose first language isn’t English 
Only refer to people’s religious or racial heritage if it is relevant to the point you 
are making. If this is the case, refer to ‘family origin’. Be accurate: consider the 
difference in meaning between ‘he is Pakistani’ and ‘he is British, of Pakistani 
origin’. 
 
Describing people by their skin colour is only pertinent in a very few situations. 
The terms BME (black and minority ethnic) or BAME (black, Asian and minority 
ethnic) were common in 2020, but be aware that they are not universally 
approved of. Be accurate and be respectful. 
 
It is best to avoid metaphors, idioms and jargon when your audience includes 
people whose first language isn’t English. Not because they lack literacy skills: 
they simply may not have come across your figure of speech before. 
 
Also, be aware that many different languages are spoken in Scotland. Over 40 
different languages are spoken by the pupils at Shawlands Academy. 
 
Lastly, it is important to be aware that many deaf people regard British Sign 
Language as their first language (around 145,000 people in 2011). 
 

Gender identity and sexual orientation 
Aim to use gender-neutral language consistently throughout your writing. Avoid 
using ‘he/she’ and ‘his/her’ to denote uncertainty. Use ‘they’ and ‘them’. 
 
Remember that sexual orientation is different from gender and gender identity: 
 
♦ Sexual orientation is about who you are attracted to. 
♦ Gender identity is about who you are. 
♦ In the Equality Act, sex can mean either male or female, or a group of people 

like men or boys, or women or girls.  
♦ Stonewall uses LGBT. Our Rainbow Network has indicated they prefer 

LGBTQI+ (lesbian, gay, bi, trans, queer or questioning, intersex and others). 
 
The terms ‘homosexual’, ‘bisexual’ and ‘transsexual’ are, according to Stonewall, 
regarded as outdated. Avoid ‘straight’ and other euphemisms. 
 

https://www.bbc.co.uk/news/uk-politics-43831279
https://www.bbc.co.uk/news/uk-politics-43831279
https://www.british-sign.co.uk/what-is-british-sign-language/
https://www.british-sign.co.uk/what-is-british-sign-language/
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If you aren’t sure — ask! Promoting equality is something SQA takes very 
seriously. SQA’s equality home page 
 

Links 
UK government guidelines when writing about disability 
Stonewall glossary of terms 
Equality and Human Rights Commission advice on sex discrimination 
 

Further reading 
Writing Around the World: A Guide to Writing Across Cultures by Matthew 
McCool 
 
 [Back] 
  

https://www.sqa.org.uk/sqa/25339.html
https://www.gov.uk/government/publications/inclusive-communication/inclusive-language-words-to-use-and-avoid-when-writing-about-disability
https://www.stonewall.org.uk/help-advice/glossary-terms
https://www.equalityhumanrights.com/en/advice-and-guidance/sex-discrimination
https://www.amazon.co.uk/Writing-Around-World-Across-Cultures/dp/082644072X/ref=sr_1_1?dchild=1&keywords=%22Writing+Around+the+World%22+McCool&qid=1588152264&s=books&sr=1-1
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Ampersands 
Always use ‘and’ instead of an ampersand ‘&’, except in: 
 
♦ company names, for example Marks & Spencer, Tiffany & Co. 
♦ widely accepted abbreviations, for example Q&A, R&D 
♦ titles of books, TV shows, movies and songs where an ampersand is already 

used, for example Eats, Shoots & Leaves, Law & Order 
♦ academic references, to cite sources in brackets with more than one author, 

for example Johnston, Ferguson, & Mete, 2021) 
 

You can use ampersands to show that an ‘and’ is part of a listed item’s name and 
not a separator, for example ‘rock, pop, rhythm & blues, and hip hop’.  
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Apostrophes 
Apostrophes have two functions: 
 
♦ They indicate possession, as in:  

‘Overall, candidates’ results in this subject show much improvement.’ 
♦ They show that a letter (or more than one) has been missed out, as in: 

‘I very much regret that I didn’t respond to your email.’ 
 

Apostrophes are never used to show that a noun is plural (this is known as the 
greengrocer’s apostrophe), as in: 
 
♦ apple’s and pear’s 45p 
♦ room’s 24 and 25 

 
The plural form of SVQ is SVQs, not SVQ’s. 
 

Difficult apostrophes 
These are the rules on when to use ’s [apostrophe s] and when to use s’  
[s apostrophe] in cases that can cause confusion: 
 
Singular words that end in the letter s take ’s [apostrophe s] in the possessive: 
 
♦ this chair is my boss’s 
♦ James’s wombat 
♦ the princess’s didgeridoo 

 
Their plurals take s’ [s apostrophe]: 
 
♦ bosses’ cars 
♦ the candidates’ evidence is assessed and verified on an ongoing basis 
 
Plurals that don’t end in s take ’s [apostrophe s] in the possessive: 
 
♦ children’s books 
♦ sheep’s clothing 

 
It’s very difficult, especially when you’re in a hurry, to get all of your its and it’s 
right. Use its when you mean the possessive and use it’s when you mean ‘it is’. 
 
♦ Every dog has its day. 
♦ It’s a disaster! 
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No apostrophe 
There is no apostrophe in the name of a decade: 
 
♦ the 2020s not the 2020’s 
[Back]  
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Appendices 
An appendix is a useful home for something that you think is helpful to 
understanding your text, but for which there is no room inside the text. It might, 
for instance, take up too much room, or it might disrupt the flow of what you are 
saying if you were to put it in the body of the text. 
 
However, appendices have their disadvantages. 
 
First, if your readers need to read the information in an appendix before they can 
understand what you are saying, they will find themselves continually flicking 
backwards and forwards between the appendix and the text. 
 
Secondly, if they don’t need to have the information that is in the appendix, they 
may well ignore it altogether. 
 
Before adding an appendix to your document ask yourself if what you are 
proposing is really so important. After all, if it were that important, you would want 
to put it in the main body of the text. 
 
The sorts of thing you might want to put in an appendix include: 
 
♦ health and safety requirements 
♦ a list of legislation that has a bearing on what you have said 
♦ statistics, included for the reader’s interest 
♦ a list of other publications to read 
♦ forms that your readers might need to copy and use (though worked 

examples are, as a rule, better included with the text) 
 

Appendices do have a role, but they can be overused. Exercise caution if you’re 
considering adding an appendix to your document. 
[Back] 
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Audience 
Deciding who you are writing for is one of the most important aspects of writing. 
You might have several audiences in mind but which is the main one? Ideally, 
once you have decided on your primary audience you should state explicitly what 
it is and then address that audience directly. This will allow you to prefer the 
active voice over the passive voice — which almost always makes your text 
clearer for your reader. 
 
If you have more than one audience and neither has priority, say learners and 
teachers, then perhaps you should consider separate documents for each 
audience. 
 
If that is not feasible you may find it helpful to think about three categories of text 
within a single document: 
 
♦ common text that meets the needs of both audiences 
♦ detail for learners — make this clear in headings 
♦ detail for teachers — again, make this clear in headings 
 
The size of each category depends on your particular document. 
 
Another approach could be to build explanations into your text so that the needs 
of both audiences can be met — but you need to be careful that you don’t 
alienate your primary audience with unnecessary detail. You might be able to 
avoid that last objection by hyperlinking to explanatory text elsewhere, but 
overuse of this technique can make things too awkward for your less 
knowledgeable readers. 
 
See the Clear and Confident Writing SQA Academy course for more on 
audience. 
[Back] 
  

https://www.sqaacademy.org.uk/course/view.php?id=703
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Brackets 
Brackets can be round (), square [], curly {}, or angled <>. 
 
Oxford recommends using round brackets for digressions, explanations, cross-
references, and references; and retaining square brackets for when you want to 
supplement original text. At SQA, we usually only use curly and angled brackets 
in STEM subjects. 
 
Try to avoid setting brackets within brackets in regular text, but if you need to 
then it is OK to use round within round (like this (yes, really)). 
 

Punctuation 
The rules for punctuation between brackets are the same as for punctuation 
within quotation marks: 
 
♦ A complete sentence inside brackets within another sentence does not take 

an initial capital or a full stop. 
♦ A complete sentence within brackets that is not part of another sentence 

takes an initial capital and ends with a full stop within the brackets. 
 
[Back] 
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Bullets 
Bullet-point lists are: 
 
♦ easy to read 
♦ visually striking 
♦ clean and neat 
 

To capitalise or not to capitalise … 
Bullet points should not be capitalised when they are incomplete sentences that 
cannot be read on their own without the stem. In this case, they should not finish 
with commas or semi-colons. (The statement ‘Bullet-point lists are:’ is the stem of 
the list in the example above.) 
 
Bullets should be capitalised, and end with full stops, when the text forms a 
complete sentence that can exist on its own. For example: 
 
‘There are numerous benefits of using bullet points: 
 
♦ They are useful for lists, allowing the reader to determine the main points 

easily. 
♦ They break up long sections of text. This will help improve the readability of 

the document.’ 
 

How to format a bullet-point list 
 

 
 
If you are using the SQA Normal template, this will set a diamond bullet as shown 
in the examples on this page. 
 
If you need to have a sub-list of bullets, use the ‘Second order bullet’ style in the 
Styles pane. This will give you a long dash (technically, an em dash) as a bullet. 
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‘Bullet-point lists are: 
 
♦ easy to read 

— each point starts on a new line 
— there is no unnecessary detail to absorb’ 

 
For Mathematics, use a square bullet for second-order bullets to avoid any 
possible confusion with minus signs. 
 
For Computing, use a circle if a third-order bullet is needed. 
 
We recommend that you restructure your text to avoid third-order bullets if 
possible. 
  

Grammatical sense 
A list of bullets should also make grammatical sense: decide whether the bulleted 
text should continue your original sentence or start a new one, and stick with your 
decision. 
 
For example, here’s how the bullets at the top of this section should not look: 
 
‘Bullet points are: 
 
♦ easy to read 
♦ they are striking, visually 
♦ bullet points are clean and neat’ 

 
Bullet points are a useful way of making text stand out on the page, but you also 
have to be wary of overusing them — too many bullet points can make text 
harder to read. If you have more than three separate sets of bullets on a page 
(that is, bullets in more than three paragraphs) it may be time for a rethink. 
 
Oxford Dictionaries on bullet points 
[Back] 
  

https://en.oxforddictionaries.com/punctuation/bullet-points
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Can or may? 
If you want to say that it is possible for candidates to be assessed by 
examination, don’t say ‘candidates may be assessed by examination’ unless 
you’re giving people permission (which implies to the reader that you are in a 
position of authority and superiority). ‘May’ can also express a vague possibility, 
as in ‘it may rain this afternoon, or it may not’. 
 
‘Can’ expresses simple capability, and is almost always the word you want. So 
say ‘candidates can be assessed by examination’ or ‘you can contact our 
Customer Contact Centre on …’ 
[Back] 
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Capital letters 
SQA’s rule for when to use capitals, and when not, is: 
 
♦ if it is the title of a specific person or thing, it takes title case 
♦ if it’s a more general name, it doesn’t 

 
Title case means initial capitals on main words only; sentence case means an 
initial cap on the first word; and lower case means no capitals at all. Most of the 
time, we use lower case. 
 
As well as words that take capitals in everyday English (such as the names of 
people and places), things that always need capitals when we’re writing for SQA 
are: 
 
♦ names of qualifications 
♦ unit and course titles 
♦ the name of the subject of an SQA qualification 
♦ publication titles (but not types of publication) 
 
Capitals are useful as signposts, and to help distinguish between different kinds 
of thing (for example: the subject History taught in school, the history of the 
school). Don’t use them, though, in an attempt to emphasise what you’re saying, 
or because a word seems important. 
 
See SQA’s Guide to Using Capital Letters for detailed guidance and examples. 
[Back] 
  

https://sqanow.sharepoint.com/sites/connections/Publishing%20and%20writing/Documents/SQA_Guide_to_Using_Capital_Letters.pdf


20 

Clear and Confident Writing course 
The Clear and Confident Writing course on SQA Academy consists of six  
30-minute modules: 
 
♦ Using Plain English 
♦ Know your Audience 
♦ Tone of Voice 
♦ Editing and Proofreading 
♦ Corporate Horror 
♦ Plain English in Practice 
 
These topics are covered in Writing for SQA, but the interactive SQA Academy 
course provides more detail along with activities to help ensure our writing is 
clear and concise for our target audiences. 
[Back] 
  

https://www.sqaacademy.org.uk/course/view.php?id=703
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Colons and semi-colons 
Colons 
There are two uses for a colon. The first is to introduce a list of things: group 
awards, courses, units, and performance criteria, for instance. The second is to 
link two phrases of equal weight in one sentence, where there is an idea of 
progression: as there is here. 
  
You can also use an em dash in these circumstances, for example: 
 
♦ The letter was brilliant: it used plain English and was easy to read. 
♦ The letter was brilliant — it used plain English and was easy to read. 

 
You should not use a colon if you already use ‘include/including’ to indicate that 
further information will follow. In the example below both are used, which is 
incorrect. 
 
‘There should be an awareness of the main historical characters: including 
Kenneth McAlpin, Macbeth and Duncan …’ 
 
It should read: 
 
‘There should be an awareness of the main historical characters, including 
Kenneth McAlpin, Macbeth and Duncan …’ 
 

Semi-colons 
Semi-colons are used to distinguish between the items in a list where it would be 
confusing to do so by using simple commas, as in this example: 
 
‘SQA works in partnership with education, business and government to ensure 
that its qualifications are: relevant to the needs of students and employers; 
flexible enough to adapt to changing economic circumstances and technological 
change; and recognised throughout the UK, Europe, and beyond.’ 
 
If you find yourself using a sentence like this, though, it is almost always better to 
use a list of bullets instead. 
 
Semicolons also join connected ideas in a sentence, often replacing the word 
‘and’ or ‘but’: 
 
I spent two hours doing the sum; I couldn’t work it out. 
 
Don’t use a colon followed by a hyphen ( :- ). 
[Back] 
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Commas 
Commas are used in two ways: to separate clauses in sentences, and to 
separate small items in lists. 

Clauses 
If you think of what you’re writing as speech, you can think of commas as the 
places where you’d pause (as you would after ‘speech’ in this sentence). If you’re 
unsure about whether to insert a comma or not, try reading your sentence aloud. 
The places where you pause are almost always crying out for a comma. If you’re 
still unsure, insert a comma anyway. 
 
Using commas really helps people to understand what you’re saying, because it 
breaks your statements down into bite-sized chunks. Here’s a moderately 
complex sentence with no commas: 
 
‘Interim reviews throughout the year will follow the same pattern as your annual 
review and will concentrate on your progress against agreed objectives noting 
any changes in objectives and progress towards achievement of your personal 
development plan.’ 
 
It’s particularly confusing around the ‘objectives noting’ area. Here it is broken 
down into chunks, and much easier on the reader’s eye and brain: 
 
‘Interim reviews throughout the year follow the same pattern as your annual 
review, and concentrate on your progress against agreed objectives, noting any 
changes in objectives and progress towards achievement of your personal 
development plan.’ 
 

Lists 
In a simple list, commas are used to separate the items, as in: 
 
‘Commas, colons and semi-colons are punctuation marks.’ 
 
However, if a list is complicated, it can be clearer to add a comma before the 
‘and’ or ‘or’ at the end of a list. This is referred to as an ‘Oxford comma’. For 
example: 
 
‘Engineering, Personal and Interpersonal Skills, Communication, Art and Design, 
and Information Technology.’ 
 
Given that our lists get even more complicated than this, it is best to be as 
rigorous as possible in separating one item from another, and the way to do this 
is by using commas. If your list contains items that are more than a few words 
long, though, use semi-colons. 
[Back] 
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Contents list 
There’s no need to manually key in a contents list in a Word document. If your 
headings have been set up using Word’s Styles feature (see Templates) then go 
to the References tab and choose Table of Contents to create a contents list 
automatically. You may have to edit the table that is generated to remove 
unwanted detail but the page numbers will be correct. 
 
If your text changes subsequently, you can update the table of contents by 
selecting it, right-clicking and choosing Update Field. You will then see the 
dialogue box below. Choose the option you need. 
 

 
 
[Back] 
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Copyright 
This is a quick reference guide that aims to address the most important aspects 
of the Copyright, Designs and Patents Act 1988. 
 
If you require more detailed information on the use of copyright and trademarks, 
please refer to SQA’s Copyright Guidelines. 
 

What does copyright protect? 
Copyright is an intellectual property right which can subsist in literary works, 
dramatic works, musical works, artistic works, films, sound recordings, 
broadcasts, and typographical arrangements of published editions. 
 

How long does copyright last? 
Copyright in a literary, dramatic, musical or artistic work (including a photograph) 
generally lasts until 70 years after the death of the author (or from the date of 
creation/public release for anonymous works). Different periods of copyright can 
apply to different types of work. 
 

Who is the copyright owner? 
The author of a work is the first owner of any copyright in it, except where the 
work is made by an employee in the course of their employment, in which case 
the employer is the first owner (subject to any agreement to the contrary). 
 

What is fair dealing?2 
‘Fair dealing’ is a legal term used to establish whether a use of copyright material 
is lawful or whether it infringes copyright. There is no statutory definition of fair 
dealing — it will always be a matter of fact, degree and impression in each case. 
 
For copying to constitute an infringement of copyright, it must involve the use of a 
substantial part of the protected work. Whether the part used is substantial is 
measured qualitatively (not quantitatively). This is a matter of fact which will vary 
from case to case. In some cases, a newspaper headline or a famous line from a 
book or song could be regarded as a substantial part. 
 
Factors that have been identified by the courts as relevant in determining whether 
a particular dealing with a work is fair, include: 
 
♦ Does using the work affect the market for the original work? If a use of a work 

acts as a substitute for it, causing the owner to lose revenue, then it is not 
likely to be fair. 

♦ Is the amount of the work taken reasonable and appropriate? Was it 
necessary to use the amount that was taken? Usually only part of a work may 
be used. 

 
2 Source: Intellectual Property Office Online (2014) Exceptions to copyright: Guidance for 
creators and copyright owners www.gov.uk/ipo 

http://www.legislation.gov.uk/ukpga/1988/48/contents
https://sqanow.sharepoint.com/sites/intranet/SitePages/Publishing-policies.aspx?web=1
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If you use copyright material and make it available to anyone (for example, by 
putting it on a public website) then it is not likely to be viewed as fair dealing. 
 

If in doubt — obtain permission 
If you use copyright material without permission or acknowledgement you may 
incur considerable financial penalties for SQA. It could also be hugely damaging 
to SQA’s reputation and any infringement could generate negative publicity. 
 

Setting or answering examination questions 
There are a number of exceptions to copyright that allow limited use of a 
copyright work without the permission of the copyright owner. This includes, in 
the case of schools and other educational establishments, anything done for the 
purpose of setting or answering examination questions, provided that the 
questions are, where possible, accompanied by a sufficient acknowledgement.  
 
This does not cover photocopying music that is to be performed in an 
examination. It also does not apply to other uses of such work, for example if the 
work is included in past papers available on SQA’s website. 
 

Use of trademarks 
If you wish to use trademarks for the purposes of examination, you should not 
need to obtain permission from the trademark owner. Nevertheless, it is good 
practice to seek permission from the relevant trademark owner to avoid any 
claims of trademark infringement or any other objections that the trademark 
owner may have against SQA. 
 

Quotations 
In 2014, copyright law changed to give people greater freedom to quote the 
works of others. You no longer need to seek the permission of the copyright 
owner as long as the quotation is accompanied by a sufficient acknowledgement 
— which generally means the title and the author’s name should be indicated, 
and as long as the use is considered reasonable and fair (fair dealing). This 
was an extension to the existing law that allowed fair dealing with copyright 
materials for the purpose of criticism, review and news reporting. 
 
Does this mean people can ‘quote’ any amount of copyright material without 
permission? No. The change only allows use of material where it is genuinely 
for the purpose of quotation, and only where the use is fair and reasonable 
(for example, it does not replace a commercial sale). So, it could permit a short 
quotation that is necessary and relevant in an academic paper or a history book, 
for example, but it would not permit a long extract. 
 

Does the ‘quotation exception’ apply to photographs? 
While the exception applies to all types of copyright work, it would only be in 
exceptional circumstances that copying a photograph would be allowed under 
this exception. It would not be considered fair dealing if the proposed use of a 
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copyright work would conflict with the copyright owner’s normal exploitation of 
their work. For example, the ability to sell or license copies of photographs for 
inclusion in newspapers would be a normal exploitation. 
 

Copyright notices 
It is important that you identify material taken from another SQA publication when 
submitting your work for publication — taking care to attribute any copyright 
material to the original source. 
 
It may be necessary to obtain permission to use previously cleared copyright 
material if you are using it in a new publication or if you intend to use the 
copyright material for a purpose that had not been previously approved by the 
copyright owner. 
 
Copyright notices are not strictly required by law in the UK but they make clear 
who owns the copyright. An example of this statement could be: 
 
Copyright © Scottish Qualifications Authority 2022. 
 

Clearance of copyright works for commercial use 
If we wish to use someone else’s copyright material (third party copyright) for 
purposes that are not covered by the exemptions mentioned above, then we 
must obtain clearance from the copyright owner. Copyright identification forms 
need to be completed by the relevant team within SQA. We need to identify the 
copyright holder and request permission to use other people’s work as early as 
possible, as sometimes it can take a long time for permission to be granted. 
 

Copyright and the internet 
It is a common misconception that simply because material is available on the 
internet, it is free to use by anyone. This is not the case. Copyright applies 
equally to material found online as it does in printed books or magazines. Always 
exercise caution when using material sourced from the internet. Every effort 
should be made to check the terms and conditions of use on the website and, if 
necessary, obtain permission and acknowledge the rights holder as set out 
above. 
 

Copyright owned by the Crown 
In some instances, Crown copyright will be available for use (including for 
commercial use) under an Open Government Licence, provided that the source 
of the information is acknowledged in a specific form (set out in the licence) and a 
link is provided back to the licence. 
However, in common with other types of copyright, each work may be different 
and therefore you should check any particular licence terms that may apply to 
Crown copyright before using it. 
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Use of social media trademarks 
The use of a social media brand or trademark is usually controlled by strict terms 
and conditions. Always read these first. They are usually available on the 
company’s website. 
 
Twitter allows users to use their original and unmodified Twitter bird to represent 
their brand. They do not allow any modification of their logo and have detailed 
rules regarding how the logo should be displayed and how accounts and 
hashtags should be promoted. 
 
Similarly, Facebook allows users to use their ‘f’, ‘Like’ and ‘Find us on Facebook’ 
logos to illustrate their presence on Facebook. 
 
YouTube allows their users to use their logo to link to a YouTube channel. 
Typically, the design and colour of logos must not be modified or used in a way 
that implies partnership, sponsorship or endorsement. 
 

Contacts for copyright queries and advice 
Question papers: Michael Gallagher and Janine Anderson, Assessment 
Development and Delivery 
 
Support materials: Melanie Beck and Maggie Quinn, Assessment Development 
and Delivery 
 
Corporate: David McCormick, Communications and Engagement 
[Back] 
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COVID-19 coronavirus 
This sentence shows how we should usually refer to the disease and virus: 
‘According to the World Health Organisation, COVID-19 is the infectious disease 
caused by the most recently discovered coronavirus.’ 
Note that: 
 
♦ ‘COVID-19’ is an acronym — COrona VIrus Disease 2019, so is all caps. 
♦ ‘coronavirus’ isn’t a proper noun — it’s a type of thing — so doesn’t take a 

cap, just as ‘detergent’ doesn’t but ‘Fairy Liquid’ does. 
 
In our emergency response docs — for colleges, ETPs, schools, etc — we’ve 
exclusively used COVID-19. 
 
However, many people refer to the disease as ‘coronavirus’, so always think of 
your audience and refer to it initially as ‘COVID-19 coronavirus’ if you think it 
makes your message clearer. 
[Back] 
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Cross-references 
When you’re referring to another publication in what you’re writing, give the title of 
that publication in title case, like this: 
 
‘You will also find a very useful and detailed explanation of the various 
instruments of assessment you can use in the Guide to Assessment and Quality 
Assurance.’ 
 
When you’re referring to another section in your own publication, or to a section 
of another publication, give the name of the section in quotation marks if it helps 
make the reference clearer, like this: 
 
‘You will also find a useful explanation of the various instruments of assessment 
in Guide to Assessment, ‘Assessment instruments’.’ 
 
However, you should also consider rephrasing: 
 
‘You will also find useful explanations in the assessment instruments section of 
Guide to Assessment.’ 
[Back] 
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Dashes 
Dashes have two similar uses: 
 
♦ You can put an explanatory phrase — like this one — in long dashes 

(technically called em dashes) in the middle of a sentence. You can’t, though, 
use more than one pair of dashes in a sentence. You can use brackets 
instead of dashes. 

♦ You can link two equally important phrases with a long dash where you don’t 
want to start a new sentence — much as you might use a colon. It is better to 
use a long dash than a colon in these circumstances. 
 

Two possible keyboard shortcuts for a long dash are: 
 
♦ Alt 0151 using the numeric keypad with ‘Num Lock’ switched on, or 
♦ Alt Ctrl Minus sign (on the numeric keypad) 
 
Two possible keyboard shortcuts for a short dash are: 
 
♦ Alt 0150 using the numeric keypad with ‘Num Lock’ switched on, or 
♦ Ctrl Minus sign (on the numeric keypad) 
 
See Range of years and Numbers for when to use a short dash or en dash. 
[Back] 
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Dates and time 
Dates should not include an ordinal suffix (in other words no 1st, 2nd, 3rd). Our 
style for dates is <day number> <month> <year>: 1 June 2020. A way to 
remember this is to remember that the units of time start small (1) on the left, and 
end up big (2020) on the right. 
 
Ensure dates appear in one line and are not separated by a line break. For 
example, writing ‘1 June 2020’ would be fine, whereas writing something like ‘1 
June 2020’ isn’t as straightforward to read and could disrupt the flow of a reader. 
 
Our style for times is the twelve-hour clock with ‘am’ or ‘pm’. Give the value in 
figures separated by a stop and with a space before ‘am’ or ‘pm’, as in these 
examples: 
 
♦ ‘I suggest we meet at my office at 12.30 pm on 23 May. Please let me know 

whether this is suitable. 
♦ If it is not suitable, I’ll also be available on 26 May from 10 am to 1 pm and 

from 2–3 pm.’ 
 

Note: there is no need to include zeroes if the time is on the hour. 
 

24-hour clock 
If you are working on a STEM document and need to adhere to ISO 8601 then 
use the 24-hour clock with a colon separator. For example: 
‘The next assessment is at 14:30.’ 
 

Range of years 
If you have to give a range of years (for instance if you’re talking about an 
academic session), use a short dash, and miss out the first two characters if 
they’re the same in both dates. So, 2019–20, but 1990–2020. 
 
Alternatively, you can use ‘from’ and ‘to’ to show the range, as in ‘from 2019 to 
2020’; but you mustn’t mix the two methods as in ‘from 2019–2020’. 
 
Two keyboard shortcuts for a short dash are Ctrl Minus sign (on the numeric 
keypad) or Alt 0150 (with Num Lock switched on). 
 

Seasons of the year 
There’s no need to give an initial capital to the names of the seasons — spring, 
summer, autumn or winter — unless they are occurring as part of the proper 
name of something, for example Summer Lightning, The Lion in Winter. In 
ordinary use, lower case is better, for example ‘let’s discuss this again in the 
spring’.[Back]  
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Diagrams, maps and graphs (line illustrations) 
If your document includes graphics that need to be drawn by an artist, please 
provide a clear drawing of each illustration on a separate sheet of A4. The 
drawings can be basic but should include all the features that you want to appear 
in the final illustration. 
 
SQA’s graphic artists are professionals, but they may not be specialists in your 
subject. Please therefore annotate your drawings with descriptions and 
instructions to help them as much as possible, circling any text that is not meant 
to appear in the final illustration as a label. Remember to number each drawing 
and indicate its position in the text. 
 
If you wish to supply a photocopy as an artist’s reference, please indicate that it is 
to be used as a reference only and is not be copied exactly in order to avoid 
infringing copyright. You should supply a written brief describing what you need 
to see in the picture and include directions to the artist as to how the SQA 
illustration and labels should be amended to avoid infringing copyright. 
 
Illustrations can be expensive and time-consuming to prepare. Please try to 
ensure that any request you contribute to your publication is not simply ‘filler art’. 
 
When supplying an image for use on web pages you must also include suitable 
text for visually impaired users — this should be a short visual description of the 
image, which will be used to describe how the image appears to screen readers 
and other assistive software. 
[Back] 
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eg, ie, NB, etc 
The Government’s digital service (GOV.UK) has started to remove Latin 
abbreviations such as ‘eg’, ‘ie’, NB and ‘etc’ from its web pages because they 
make reading difficult for some readers and can confuse screen readers. 
 
We are also now following this approach and in main text suggest replacing ‘eg’ 
with ‘for example’, ‘ie’ with ‘that is’, and ‘NB’ with ‘Note:’. However, for tables 
where space is limited we’d suggest the continued use of ‘eg’ and ‘ie’. 
 
Both ‘eg’ and ‘ie’, if you choose to use them, should follow a dash — eg like this 
— or a comma, ie like this, or should appear in brackets. You shouldn’t give them 
full points — ie don’t use ‘i.e.’. 
 
If you need to use an abbreviation for ‘and so on’, you should write ‘etc’ (not &c. 
or etc.). 
 
You should, though, use ‘etc’ with caution — don’t just put one in to be on the 
safe side, or when you can’t think of anything else to go in the list. Have a real 
reason for it. 
 
You must also avoid using more than one of these abbreviations in any clause — 
you should never write: 
 
eg English, French, German, Gaelic, etc 
 
Write: 
 
English, French, German, Gaelic, etc 
or: 
eg English, French, German, Gaelic 
[Back] 
  

https://insidegovuk.blog.gov.uk/2016/07/20/changes-to-the-style-guide-no-more-eg-and-ie-etc/
https://insidegovuk.blog.gov.uk/2016/07/20/changes-to-the-style-guide-no-more-eg-and-ie-etc/
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Elision (you’re, we’re, here’s, etc) 
Elision or contractions are perfectly appropriate in most circumstances: in 
newsletters, anything labelled as ‘guidance’, and communications addressed to 
teachers, lecturers, people in the workplace, or candidates. It’s perhaps less 
appropriate in procedural documents, or course and unit specifications — 
documents that have an almost legal tone — but these are the exception rather 
than the rule. 
 
Don’t feel that you can’t use ‘don’t’ or ‘can’t’ or ‘you’re’, and if it helps you to write 
in a more natural style (because it’s closer to the way you speak), use it. It is 
always better, when you’re writing a first draft, to be too informal than to be too 
formal. Informality is an aid to clarity. 
[Back] 
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Ellipsis … 
The mark we use for ellipsis (which you should use when you want to show that a 
chunk of text has been left out of a passage you are quoting) is three points … 
like this. Here’s an example: 
 
‘The mark we use for ellipsis … is three points’ (Alt Ctrl <full stop>). 
 
There is always a space before the ellipsis character, except when it comes at 
the beginning of a quoted sentence. 
[Back] 
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Email 
It’s easy to reach for the keyboard to bash out an email, but there are times when 
this can cause an adverse reaction. A phone call can often be a more effective 
way to sort out a problem. Perhaps the other person would simply feel better 
(about SQA) if you took the trouble to speak to them in person? 
 
If an email is the right way for us to be communicating (and it often is), try to keep 
in mind the following four points and you will produce a professional 
communication that is readily understood and that supports SQA’s business 
goals. 
 
♦ Address your reader directly as if you were talking to them. 
♦ Write clearly. 
♦ Be positive and confident. 
♦ Look and sound professional. 
♦  

Talk to your reader 
There’s sometimes a tendency for the tone of business writing to be pitched in 
remote and formal language, but there is really no need for this to be so. Use 
natural, everyday language and avoid being overly formal. If it’s something you 
wouldn’t consider saying in speech to your reader, then don’t write it down. 
 
This includes the salutation: 
 
♦ If there is a need to be formal (for example, if you are writing to a customer or 

a member of the public) and you know the name of the person you are writing 
to then you should say ‘Dear Mr/Ms/Mrs/Mx/Miss/Dr <surname>’. If you know 
what they use, use that. 

♦ If you know the person and have an established working relationship with 
them you might say ‘Hi <First name>’ or just ‘Hello’. 

♦ But what if you are writing to individual and you don’t know their name, or you 
are writing an email that will be sent to a large audience? You then have a 
choice of ‘Dear colleague’ or perhaps ‘Hello’. Try to avoid ‘Dear Sir/Madam’. 
 

Many of our emails are written to people in SQA centres who are doing the 
organising and administration running our qualifications demands. Once you’ve 
made this plain in the subject line of your email, there is no reason why you 
shouldn’t then address them as ‘you’ throughout the text, rather than referring to 
‘centres’. 
 

Don’t say … 
‘Centres should retain candidates’ work for verification.’ 

Do say … 
‘You should retain candidates’ work for verification’. 
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Keeping it clear 
If there is one basic principle for writing clearly, it is this: keep it short and simple. 
This applies to words, sentences and paragraphs. 
 
Say what you want to say in as few words as you can and don’t be vague. For 
example, say ‘We advise ...’, not ‘We would advise …’. 
 
Prefer active verbs over passive verbs. For example, in ‘Lesley drafted the email.’ 
the verb ‘drafted’ is active, while in ‘The email was drafted by Lesley.’ it is 
passive. 
 
More about active and passive 
 

Do say … ‘We have decided that …’ 
‘We recommend …’ 

Don’t say … ‘It has been decided that …’ 
‘It is recommended ...’ 

 
Similarly, avoid constructions like ‘centres are advised …’. 
 

Be positive 
Focus on what we will do, rather than what we can’t or won’t. Also, don’t be afraid 
to apologise if we have made a mistake — but say what we’re doing to put it 
right. 
 

Do say … ‘We will provide the information you 
requested by 28 February.’ 

Don’t say …  ‘We cannot provide the information 
you requested until next month.’  

 
Use co-operative vocabulary like ‘help’ and ‘work with’ to show that we work as a 
team. 
 

Look professional 
Although they’re less formal than many other forms of writing, it’s still important 
that emails from SQA are as professional as possible. This means checking for 
easily avoidable errors — factual errors, of course, but also spelling mistakes and 
grammatical errors. Turn on the spellchecker (and leave it on). Then check your 
message over. If possible, get someone else to read it before it goes out, or leave 
a few minutes between writing and sending. 
 
You should also probably avoid jokes, unless you know the recipient very well. 
There are other aspects to being professional. For instance, you can make 
messages look as neat and business-like as possible by avoiding background 
colours and setting up a signature that will appear at the foot of every email that 
you send. 
If you're thinking of communicating with a group of stakeholders or customers it 
may be appropriate to make use of SQA’s e-fulfilment system, which is used for 
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our Centre News updates. Please contact communications@sqa.org.uk to 
discuss your requirements. 
 

Signing-off 
If you were writing a letter and you had opened it with ‘Dear colleague’ the 
traditional sign-off would be ‘Yours faithfully’ but is there any need to use such an 
archaic term in an email? Well, as always, it depends on who you are writing to, 
but in most business emails you can probably drop it altogether. However, don’t 
just finish your message without some form of sign-off. Try to say something that 
reflects the content of your email, but if that is not feasible, you could try ‘Thank 
you’ or ‘Regards’ or ‘Hope you find this helpful’. 
 
You should always sign-off emails with your name. This is important even if you 
are responding from a team mailbox because it lets your customer or colleague 
know who has actually attended to their query and who they should contact if 
they need to phone. They may also want to thank you personally. 
 
PS — you can use a ‘post script’ if you want to draw attention to something that 
you’ve already mentioned or to provide further information. 
 

Email signatures 
An email signature provides valuable information and looks professional and 
trustworthy. Here is an example of what you should include: 
 
Your name  
Your business area 
Your directorate 

t: phone no | m: mobile no | e: email address | w: http://www.sqa.org.uk 
Scottish Qualifications Authority 
Lowden, 24 Wester Shawfair, Dalkeith, Midlothian, EH22 1FD  
The Optima Building, 58 Robertson Street, Glasgow, G2 8DQ 

To create an email signature in Outlook: 
 
1 Open a new email message. 
2 On the Message menu, select Signature, then Signatures. 
3 Under Select signature to edit, choose New, and in the New Signature 

dialogue box, type a name for your signature. 
4 Under Edit signature, create your email signature. 
 

Further reading 
The Essential Guide to Crafting a Work Email (Harvard Business Review) 
[Back]   

mailto:communications@sqa.org.uk
mailto:email
http://www.sqa.org.uk/
https://hbr.org/2015/07/the-essential-guide-to-crafting-a-work-email&cm_sp=Article-_-Links-_-End%20of%20Page%20Recirculation
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Emphasis 
Keep emphasis to a minimum or you won’t be able to see the wood for the trees. 
If you want to emphasise text in a professional document — use bold, not italic 
or underline — AND DON’T USE CAPITALS because it means you are shouting 
at your reader. You can also use bold to highlight new terms in learning and 
teaching materials. Don’t use underlining to emphasise text, as screen readers 
won’t be able to read it. 
 
Don’t use italic if you are writing web page text — italic text is harder to read on 
screen.  
 
You can remove the need to use italics for emphasis by using short sentences 
and placing important information at the beginning of a paragraph (frontloading). 
This will make your text more accessible to people using screen readers. 
 
It is important to note that italics are not good practice for web copy and will be 
removed before publication.  
[Back] 
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Footnotes 
Avoid giving footnotes in any piece of writing that is for public consumption. 
Footnotes can appear intimidating, so it is better to give whatever information you 
want to convey in the body of your text and, if possible, limit footer text to version 
and page numbers.  
 
If you have to use a footnote, go to the References tab in Word and select Insert 
Footnote. Your footnotes should be the same font size as your body text. 
 
 

 

[Back] 
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Foreign words 
Try to avoid using words from other languages that haven’t been fully naturalised 
into English, because they make it hard for people who don’t know the language 
in question to understand. 
 
If you must use, say, a Latin word, assume that it has been fully adopted into 
English, and treat it as an English word, if possible. The only exceptions to this 
general rule are some scientific and mathematical terminology; and Latin words 
ending in ‘-a’, which tend to take ‘-ae’ plurals. 
 

Specific foreign words and their plurals 
The plural of ‘forum’ is ‘forums’ (unless you’re writing about ancient Roman town 
planning features). 
 
The plural of ‘consortium’ is ‘consortiums’. (People do use ‘consortia’, but often 
incorrectly, giving rise to ‘consortia-developed Higher National Qualifications’, 
which is logically impossible.) 
 
‘Syllabus’ causes enormous confusion. There’s no evidence for ‘syllabus’ actually 
being a Latin word (it doesn’t look like a Latin word), or a Greek word, so we can’t 
begin to tell what its classical plural might have been. In English, it’s always 
‘syllabuses’ in the plural. 
 
It’s perfectly acceptable in modern English to use ‘data’ as a singular (‘the data 
shows us that uptake is increasing …’). It’s very strange to see its Latin singular 
(datum) used outwith scientific journals, and unusual to see ‘data’ being used as 
a plural — except in computing texts. 
[Back] 
  



42 

Google Images 
Many writers find Google Images to be a useful source of photographs. However, 
even if an image is identified as free for educational use, it does not mean that it 
can be published without permission. 
 
All images are protected by copyright although some may have a Creative 
Commons licence that does not require you to seek permission to use them. 
Where images on Google Images do not have a Creative Commons licence, it 
usually proves impossible to obtain permission to use them, because either the 
copyright owners are hard to trace or they don’t reply to emails. 
 
Rather than using Google Images, we recommend using a stock photography 
site that SQA has an arrangement with, for example Shutterstock. 
Note: there are different accounts in use across the organisation. Speak to 
Procurement to find out if your business area already has an account. 
[Back] 
  

http://www.shutterstock.com/
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Grammar myths 
Myth: you musn’t use prepositions at the end of sentences 
Prepositions relate nouns or pronouns to the rest of a sentence and include 
words like ‘with’, ‘on’ and ‘at’. So, traditionally, putting them at the end of a 
sentence was frowned on. However, this inspired the following quote from 
Winston Churchill: 
 
‘From now on, ending a sentence with a preposition is something up with which I 
shall not put.’ 
 
If a preposition is going to fall at the end of a sentence naturally, let it stay there. 
Go on. It happens naturally in English, and is something we should all be 
perfectly comfortable with. 
 

Myth: you mustn’t use split infinitives 
There aren’t actually any infinitives in English — instead we have a form 
consisting of ‘to’ with the verb stem — so it follows that you can’t really split an 
infinitive. You may be uncomfortable, though, with the idea of putting something 
between your ‘to’ and your verb stem, but don’t go out of your way to avoid it, 
especially when you’re saying something like ‘to fully appreciate’, or ‘to 
completely understand’. 
 

Myth: you must always use ‘you and I’ 
There’s no rule that says you always have to say ‘you and I’ — it’s often ‘you and 
me’. 
 
If you’d say ‘me’ when there was no ‘you and’, say ‘you and me’: 
 
♦ ‘According to you and me’ 
♦ ‘Done by you and me’ 
♦ ‘Arranged for you and me’ 
 
If you’d say ‘I’ when there was no ‘you and’, say ‘I’: 
 
♦ ‘You and I should meet’ 
♦ ‘You and I know’ 
♦ ‘You and I are too old for this’ 

 
There’s more about this topic at: https://en.oxforddictionaries.com/usage/i-or-me. 
 
  

https://en.oxforddictionaries.com/usage/i-or-me
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Myth: every ‘if’ requires a ‘then’ 
It’s not necessary to introduce the complement of every conditional with a ‘then’. 
The meaning is usually quite plain from the context, and saying ‘then’ can 
actually confuse people, who might read ‘then’ as a reference to a time. For 
instance, ‘If you worry about tomorrow, you won’t sleep’ is perfectly 
straightforward. ‘If you worry about tomorrow, then you won’t sleep’ introduces an 
unnecessary ambiguity, because you can read it as saying ‘you won’t sleep 
tomorrow if you worry about tomorrow’. 
 

Use of ‘shall’ 
It’s not necessary to use ‘shall’ for the first person (I and we) future. Use ‘will’. 
Indeed, it’s not necessary to use ‘shall’ at all — it can sound a bit pompous — 
and its use is declining rapidly. 
[Back] 
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Hyphens 
There is no consistent rule on when to hyphen and when not, but a general 
principle is that two words should be hyphened if: 
 
♦ they are more closely related to each other than to the other words in the 

sentence 
♦ it is more confusing not to hyphen them 
 
Consider the phrase ‘temporary evidence record’. Without hyphens it is unclear 
whether it is the evidence that is temporary or the record — if the latter sense is 
meant, ‘temporary evidence-record’ would be clearer. Note, though, that it would 
be better still to recast the phrase, for instance as ‘temporary record of evidence’ 
(see Nouns as adjectives). 
 
Always hyphen these terms: 
 
♦ centre-devised 
♦ cross-marking 
♦ work-based 
♦ candidate-centred 
♦ part-time (and full-time) 
♦ project-based 
♦ nationally-recognised 
♦ vocationally-focused 
 
Always use a hyphen before ‘oriented’ and ‘based’ when they are being used in a 
compound — for example, ‘people-oriented approach’ or ‘work-based learning’. 
The prefix ‘re-’ usually takes a hyphen before a vowel: re-assess, re-establish, re-
evaluate, re-examine, re-open, re-order, re-organise, re-use (all hyphened). 
 
If you’re using ‘e’ for ‘electronic’, remember to give it a hyphen. The exception is 
‘email’ which is now almost always used in preference to ‘e-mail’. However, other 
‘e-‘ terms can be confusing if you don’t use the hyphen — for example, if we are 
writing about ‘eenabling eassessment in egovernment and ebusinesses’. 
 
Treat ‘e-’ words as you would any other — capitalise the ‘e’ at the beginning of a 
sentence (for example, say ‘Email is a great way to communicate.’ not ‘eMail is a 
great way to communicate.’). 
 
‘Pre-’ takes a hyphen before a vowel: pre-arrange, pre-existing, pre-ordained. 
 
‘Co-’ takes a hyphen before an ‘o’: co-operate, co-ordinate (unless you’re talking 
about coopers or chicken coops).[Back] 
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-ise or ize? 
Words that have the -ise ending (to rhyme with ‘eyes’) are spelled with an ‘s’ 
(recognise, customise, advertise, homogenise), not with a ‘z’. Make sure you 
have spelling set to English (UK), rather than English (US), so that Word doesn’t 
try to correct any -ise endings. 
 
‘Analyse’ also takes an ‘s’, not a ‘z’. 
[Back]  
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Its or it’s? 
The difference between its and it’s is that its is possessive, and it’s is a short 
form of it is. 
 
♦ The one thing about Scotland I don’t like is its weather. 
♦ Oh look, it’s raining again. 

 
Beware of situations where these two are easily confused: 
 
♦ The great thing about the SVQ is its adaptability. 
♦ The great thing about the SVQ is that it’s adaptable. 
[Back] 
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Jargon 
Highly specialised language with many technical terms is not always easy to 
avoid, but there are steps you can take to minimise the bafflement readers feel. 
There may be other words for ‘articulate’ (in the specialised sense in which we 
use it) and for ‘implementation’. Please try to find alternatives. 
 
We also have a tendency to say things like ‘the entering of candidates for 
examinations’ when we could just as easily say ‘entering candidates for 
examinations’. Avoid this sort of construction, because it can seem pompous and 
mystifying. 
 

Don’t write … the recording of evidence 
the entering of candidates 
the implementation of SQA 
qualifications 
the use of  

Do write … recording evidence 
entering candidates 
implementing SQA qualifications 
using 

 
Plain English Campaign’s ‘A to Z of alternative words’ 
[Back] 
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Mathematics 
Use MathType to set equations in Microsoft Word. 
 
If you don’t have access to MathType, please don’t try to emulate complicated 
layouts in Word using the tab key and the space bar. Use brackets to indicate the 
structure of equations and formulae, and don’t indent anything. 
 
For example: x = [-b ± √(b2 – 4ac)]/2a <Display> 
 
We will then set this as: 
 

 b b acx
a

− ± −
=

2 4
2

 

 
Alternatively, just handwrite the equations. 
 
If you intend to set at least some of the mathematical content of your text, then 
please format your text as follows: 
 
Use italic for variables and algebraic constants, for example ax bx c+ + =2 0 . This 
also holds for superscripts and subscripts, for example na =1 for n = 1, 3, 5… 
 
Use roman for labels and for: sin, cos, tan, lim, det, log, ln, e, i, Re, Im 
 
Use bold, non-italic Times New Roman for vectors, for example a × b = c 
 
Please leave a single space either side of an operator such as + or ×. 
 
Units are set in lower case, even if they are based on someone’s name, for 
example watt, kelvin, volt and their abbreviations are capitalised: 100 W, 273 K, 
240 V. But note the temperature unit ‘degree Celsius’ (°C) contains a capital 
letter — see BSI (2013) Quantities and units, BS EN ISO 80000-1:2013 (page 
26). 
 
Please either use Insert > Symbol for multiplication signs and degree symbols or 
use the keyboard shortcuts below. Don't use the letter 'x' or superscript 'o'. 
 

Keyboard shortcuts 
First make sure that Num Lock on your numerical key pad is switched on. Then 
holding down the Alt key, type the four-digit codes on the numerical key pad. 
 
Raised decimal point · Alt 0183  
multiplication sign × Alt 0215 
division sign   ÷ Alt 0247 
minus sign (en dash) – Alt 0150 
degree symbol ° Alt 0176 
[Back]  
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Money, weights and measures 
Money 
The pound sign (£) and the pence sign (p) must never be used at the same time. 
Use £0.84 or 84p — but keep to one style within a document. 
 
There must always be two digits after the decimal point, unless there are no 
pence, when the amount can be typed like this: £7. 
 
This rule also applies to the euro and cent, the US dollar and cent, and all other 
currencies. 
 

Weights and measures 
Insert a space between the number and the unit of measurement, for example: 
 
♦ 25 mm 
♦ 89 g 
♦  

Percentages 
Use either 25% or 25 per cent — but keep to one style within a document. 
[Back] 
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Nouns 
Collective nouns 
Words such as Government, Scottish Enterprise or HM Inspectorate sometimes 
look as if they’re plural, but we treat them as singular. So, for instance, you 
should say: 
 
‘the Government is doing this’ not ‘the Government are doing this’. 
 
The same is true for ‘SQA’: 
 
‘SQA is responsible for …’ not ‘SQA are responsible for …’ (though, of course, 
you can say ‘we are responsible for …’) 
 

Nouns as adjectives 
Please try not to use nouns as adjectives. In the phrase ‘candidate evidence 
judgement record’, every word is a noun, as is every word in ‘school curriculum 
unit information pack’. 
 
At best, this sort of construction is unattractive. At worst, it can be confusing, or 
even incomprehensible. This is because there are several possible ways for 
readers to guess the meaning. Is a ‘candidate evidence judgement record’ a 
record of candidates’ judgements about evidence, a record of judgements about 
evidence of candidates, a record of judgements about candidates’ evidence, or a 
record of evidence judgements about candidates? Are some, or all, of these the 
same? It takes unnecessary time and effort to work this out. 
 
The best thing to do is to try to break up the string of nouns. This may involve 
using a couple of extra words here and there, but you will find that the sense you 
want to convey comes across more clearly. The two examples we gave earlier 
would be better given as: ‘a record of judgements of candidates’ evidence’ and 
‘an information pack for schools on units in the curriculum’. 
 

Nouns as verbs 
Similarly, try to avoid turning nouns into verbs, which can also be confusing. For 
instance, instead of ‘mainstreaming e-assessment’, try ‘making e-assessment 
mainstream’. 
[Back] 
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Numbered lists 
Use the following format. It is similar to that used for question papers but with 
smaller spacing: 
 
1 Use arabic numbering with no point and a tab of 0.63 mm. 

(a) Use letters with opening and closing brackets for sublists. 
Indent, tabs and hanging indent are 0.63 mm. 
(i) Sub-sublists use lower case roman numbers with opening and closing 

brackets. Indent is 1.27. Tabs and hanging indent are 0.63 mm. 
 

Please avoid using the auto-numbering function in Word — insert your numbers 
manually. This is especially important for headings, and even more important if 
you are including any cross-references. The reason for this is that  
auto-numbering falls off as soon as we change the paragraph style or paragraph 
attributes (as we often do while editing), and doesn’t import into typesetting 
applications (such as InDesign). 
[Back] 
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Numbers 
The rules for giving numbers in non-science subjects are: 
 
♦ The numbers one to nine should be written out in full, as they have been here 

unless they are part of a series of numerical data (see below). 
♦ The numbers 10 and above should be given as figures. If numbers less than 

10 and more than 10 appear together in the one sentence, make them all 
figures. 

♦ Use figures in tables and equations. 
♦ For numerical data, always give exact amounts in figures — this applies to 

money, quantities, and time, as well as to the credit value of a qualification, or 
its level. 

♦ For STEM subjects, set four-digit numbers close up without a comma (like 
this: 1500). And set numbers with five digits or more with a thin space (6 pt) in 
place of a comma separator (for example: 50 000). One way to set a thin 
space is to key the number 2009 where you want the space to appear, then 
select the 2009 and key Alt + X. You might want to then copy the space and 
paste it into other instances. 

♦ Use the comma separator for all other subjects and non-science contexts (for 
example: 1,500 or 15,000 or 150,000). 

♦ At the beginning of a sentence, always either write the number out in full, 
even if it is greater than 10, or recast the sentence. Recasting the sentence is 
the better option for numbers that are greater than 100. Marks are an 
exception: they are always written using figures — even if they appear at the 
start of a sentence. 
 

Do say … Don’t say … 
‘Results have shown improvement 
this year. Thirty-one candidates 
achieved grade C.’  

‘Results have shown improvement 
this year. 31 candidates achieved 
grade C.’  

‘The number of candidates achieving 
grade C was 31,607’. 

‘Thirty-one thousand six hundred and 
seven candidates achieved grade C’. 

 
Note that compound numbers written out in text (thirty-one, sixty-seven, and so 
on) should be hyphened. 
 
To show a range of values, use a short dash with no space between the figures 
(for example 3–15 curriculum, 100–150 candidates). The keyboard shortcut for a 
short dash is Alt 0150. (You need to have Num Lock on.) Note that a short dash 
is slightly longer than a hyphen, which has its own key. 
 
Decimal points are on the line, not raised. 
[Back]  
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Obliques 
The oblique symbol (also known as a solidus, stroke or forward slash) is often 
used to denote alternatives, for example: 
 
‘Tea/coffee will be available at 3.00 pm.’ 
 
But does the oblique mean ‘and’ or ‘or’, or both? 
 
Traditionally, it has meant ‘or’, but it is best to make your meaning clear by using 
‘or’, ‘and’ or ‘and/or’. 
 
If possible, you should reword your text to avoid using an oblique. For example, 
you could replace ‘written and/or oral recorded evidence’ with ‘written or oral 
recorded evidence or both’. 
 

Dates 
Obliques are sometimes used in dates (for example: 2019/20) but SQA house 
style is to use en dashes (as in 2019–20). See Dashes for more on this topic. 
 
[Back] 
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Page numbering 
Pages in SQA documents should be numbered consecutively 1, 2, 3, etc. Do not 
use the style ‘Page 1 of 22, Page 2 of 22’. Page numbers should be inserted in 
Word as follows: 
 
1 Select Insert > Page Number, and then choose the location and style you want 

(Bottom of page, Plain number 3). 
2 If you don't want a page number to appear on the first page, select Different 

First Page. 
3 If you want numbering to start with 1 on the second page, go to Page Number 

> Format Page Numbers, and set Start at to 0. 
4 When you're done, select Close Header and Footer or press Esc. 
 
Page numbering in SQA documents should be right sided and 11pt font size. 
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Phone numbers 
Put a space between the area code (for example 0141 or 0131) and the next 
three digits, then another after those, for example 0141 278 1000 or  
0131 561 1000. 
 
For mobile phone numbers, where there’s no area code as such, insert a space 
after the first five digits to leave a group of six to the right. 
[Back] 
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Photographs 
If you are providing photographs for a document, please supply JPEG files at the 
highest resolution your camera can work at. 
 
Stock photography websites can be a good source of high-quality images. They 
are particularly good for images of everyday items and situations. If you need this 
kind of image for your publication, try browsing Shutterstock. You can collect 
anything suitable into a ‘lightbox’ for later reference or select and drag  
low-resolution copies into a Word file. You need to register to use the lightbox 
facility. 
 
Note: there are different accounts in use across the organisation. Speak to 
Procurement to find out if your business area already has an account. 
[Back] 
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Plain English 
Plain English is about writing clearly and concisely with your reader in mind. It 
allows you to say what you mean, in a way people will understand. 
 
Using plain English is also part of promoting equality, because by writing in a 
simple and straightforward way, we’re not (deliberately) excluding anyone. It 
allows us to fulfil our duties to abide by equalities legislation. 
 
Plain English is an ideal way to demonstrate the ‘enabling’ and ‘trusted’ parts of 
our corporate values. 
 

Use short sentences 
Express one idea, simply, then stop. Don’t try to cram too many ideas in one 
sentence. Break down what you have to say into smaller bits, and express each 
bit as a separate sentence. 
 
If you find that you are writing many sentences which contain more than 30 
words, it is likely that your readers are going to find them confusing. 
 

Addressing readers 
As you write, think about your reader and how you can make the document 
useful for them. Make it clear who you are writing to in the subject line or 
introduction then address your target reader as ‘you’ throughout the text. 
 

Do say… ’Don’t say… 
‘You should keep candidates’ work for 
verification.’  
 

‘Centres should keep candidates’ 
work for verification.’ 
 

 
If it’s something you wouldn’t consider saying in speech, then don’t write it down. 
 

Prefer active to passive 
Try to mostly use an active construction, that is, one where A does B: 
 
‘The teacher (A) spoke to the class (B).’ 
 
A passive construction is one in which B is done by A: 
 
‘The class (B) was spoken to by the teacher (A).’ 
 
There are, of course, some things that are better expressed as passives. You can 
use the passive voice to avoid placing blame or to soften a statement. For 
example: 
 
‘…the invoice for this event has not been paid’ may produce a more positive reply 
than ‘…you didn’t pay our invoice’. 
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But passives do depersonalise text and make it seem very remote from the 
reader. The more passives there are in a text, the more this is reinforced. The 
effect this has is to give readers the impression that we are bureaucratic and 
distant (which is not the way we are at all). 
 

Do say… Don’t say… 
‘We decided …’ ‘It has been decided …’ 

‘We recommend …’ ‘It is recommended …’ 

 
Similarly, avoid constructions like ‘centres are advised …’. 
 

More on active and passive 
Find out more about how to write in plain English from the Plain English 
Campaign and from the Plain English module of the SQA Academy Clear and 
Confident Writing course. 
 
See our equalities web page. 
[Back] 
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Planning and structure 
The first thing to think about is ‘Who is going to read my document?’ As you go 
through the planning, writing and editing process, think about your target reader 
and how you can make the document useful for them. 
 
Secondly, consider the purpose of your document — why your reader will use it. 
It could be to report, to inform, to explain, to ask, or to persuade. 
 
Thirdly, what do you want your reader to do with the information you are giving 
them? In other words, what will be the impact of the document? For example, it 
may be to adopt a product, to implement or explain a new policy, to plan the 
content of lessons, or to carry out assessment according to revised procedures. 
 

Planning 
It might help you if you think of what you have to say as a story. Imagine yourself 
explaining whatever it is you’re writing about to an audience and having to make 
them follow your line of thought. It might help to number your points to check that 
they follow one another in a logical order. 
 
The plan you make will probably form the basis of your sections when you come 
to write. Here’s an example of a plan for a fictitious publication for learners, the 
Guide for the Group Award in Picture Framing: 
 
1 Introduction: who the guide is for 
2 An explanation of the units, their purpose and structure 
3 What you will need to do the group award 
4 What will happen when you do the group award 
5 How to gather evidence 
6 How to record evidence 
7 What happens next 
8 What you can do after you’ve done the qualification 
9 More information/contacts 
 
If you find you can’t write a plan like this, you’re probably not yet ready to write 
your document. You will have to sit down and think again, or ask for advice. 
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Sections (or chapters) 
Long documents should be divided into self-contained sections. You should use 
each section to say everything you have to say about an aspect of your subject 
matter. If you are writing a section on, for instance, assessment instruments, 
don’t let what you have to say about assessment instruments spill over into your 
section on verification. 
 
Similarly, you mustn’t repeat chunks of text from one section in another. It may 
well be, for instance, that what you’ve said in your portfolio-building section about 
the amount of evidence needed in a portfolio has a bearing on internal 
verification, but that is no reason to quote it in full. Use a reference — for 
example ‘see page xx’, or ‘see section 13, ‘Building a portfolio’’. 
 

Subsections 
Sections of a document can be divided into subsections. For instance, you might 
have a section on Core Skills in your guide for teachers for Higher Latin, and 
each of the five Core Skills could have its own subsection. 
 
Numbering subsections or paragraphs can be useful for referring readers to 
particular bits of your document, but it also gives documents a very bureaucratic 
feel. A better and friendlier way to enable readers to find their way to the bit they 
want to look up, if they’re interested in recording evidence, for instance, is to have 
a subheading saying ‘recording evidence’ and a listing on the contents page. 
 
Don’t number your paragraphs or subsections like this: 
 
1 
1.1 
1.2 etc 
 
unless it is in, for example, a committee paper or an agenda. 
 

Reading what you are writing 
Almost as important as having a plan is reading what you have written. Once you 
have started, go back as often as you like and look at what you have said. 
Particularly, look for places where you have repeated yourself, or where you have 
contradicted yourself. 
 
If you have a clear idea of what you have already said, you will minimise the risk 
of getting confused. This will save editing time, and help you keep down the 
number of words you use. 
 
If you need advice on planning and structuring a particular document, contact 
SQA’s editors at marketing@sqa.org.uk. 
[Back] 
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Plural(s) or singular(s) 
Try to avoid using ‘(s)’ when you’re talking about something that could be either 
singular or plural. It can be a useful shorthand in a simple list of bullet points, but 
most of what we write is made up of sentences, with verbs and so on. One 
problem with using (s) is that the verb or verbs you’re using won’t agree with the 
subject of the sentence. For instance, the sentence: 
 

‘Check that your label(s) are attached as shown in the diagram.’ 
 

can be read as ‘Check that your label are attached …’, which is a grammatical 
error of the kind that makes us look silly and causes complaints. To make this 
correct, you’d need to write: 
 

‘Check that your label(s) is (are) attached as shown in the diagram.’ 
 

Worse, it can make the sentence unnecessarily hard to understand — and that’s 
especially true when there are lots of instances of ‘(s)’: 
 

‘Check that your candidate(s) has (have) submitted his or her (their) script(s) 
and not his or her (their) rough working sheet(s).’ 
 

It’s best to choose either singular or plural and stick to it — in the vast majority of 
cases the meaning will be clear. If you really need to specify that there can be 
one or more of the thing you’re talking about, try recasting your sentence so that 
you can use an expression like ‘one or more’. Most of the time, though, this isn’t 
necessary. 
[Back] 
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Quotation marks 
Always use single quotes (’) when citing speech or quoting from a text. Double 
quotes (“) can only be used for quotes within quotes, like this: 
 
‘So I said to him, “What do you think you’re doing?” and I meant it, I can tell you.’ 
 
You are unlikely to need to use this sort of construction often when writing for 
SQA. 
[Back] 
  



64 

Quoting from other documents 
When you’re referring to an SQA publication for the first time in a document, give 
its title and hyperlink the title to the web page that it appears on. Never lift chunks 
out of the other publication and repeat them in your document — use a 
reference, for example ‘see Guide to Assessment, page xx’. 
 
The main reason for not quoting large chunks of text from other publications is 
that the publication you are quoting from may be out of date long before the one 
you are writing. 
 
In a situation where you don’t think your reader will have access to the document 
there is overlap with, you can quote very short passages (say no more than two 
sentences), or paraphrase its arguments, but please keep this to a minimum. 
 
See also Referencing. 
[Back] 
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Referencing 
You should provide a list of references to books, journals, and websites 
mentioned in your text to help your readers identify and locate them. You can do 
this in footnotes, or a bibliography — try to keep your text as uncluttered as 
possible. 
 

Harvard referencing 
SQA uses the Harvard (author, date) system. 
 

In the main text 
Give the author’s surname, the year of publication, and possibly a page reference 
in the text, and then list the full reference at the end of your document. For 
example, a citation in the text might look like: 
 
‘Disciplinary procedures should be in writing’ (Hannagan, 2012, p302). 
or 
‘Hannagan (2012) says that disciplinary procedures should be in writing.’ 
 

In the bibliography 
For a book, the reference in a bibliography would then appear as: 
 
<author’s surname>, <initials> (year of publication) <title>, <edition (if not the 
first)>, <place of publication: publisher>, <page number (if relevant)> 
 
For example: 
 
‘Hannagan, T. (2012) Management Concepts and Practices, 3rd ed, Harlow: 
Prentice Hall, p39’ 
 
A journal article should appear as: 
 
<surname>, <initials> (year of publication) <title of article>, <journal title>, 
<volume> (issue), <page numbers> 
 
For example: 
 
‘Evans, W.A. (1994) ‘Approaches to intelligent information retrieval’, Information 
Processing and Management, 7 (2), 147–168’ 
 
An internet reference should appear as: 
 
<*author’s/editor’s surname>, <initials> (year) <article title>, <place of 
publication: publisher>. Available from: <URL> 
 
*Note that the author may be an organisation, and place/publisher may not 
always be ascertainable — provide as much detail as possible. It is also best 
practice to add [date last accessed] but we will not use this in final publications. 
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Links to websites can be short-lived, so check that any web links are current at 
the time of writing. Make sure that you convert any web addresses in your 
document to working hyperlinks. 
 
For example: 
 
‘Academic Services, (2007) BU guide to citation in the Harvard style: brief guide, 
Poole: Bournemouth University. Available from: 
https://www1.bournemouth.ac.uk/discover/library/using-library/how-guides/how-
cite-references [accessed 06 March 2019]’ 
or 
SQA, (2019) Your Exams 2019 (BD7899), Glasgow: Scottish Qualifications 
Authority. Available from: 
https://www.sqa.org.uk/sqa/files_ccc/SQA_Your_Exams_2019.pdf  
[accessed 06 March 2019] 
[Back] 
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Referring to SQA’s qualifications 
When you’re talking about SQA’s ‘product’, use ‘qualifications’. Don’t use ‘award’, 
as this is used to refer to the grade a candidate achieves, for example A or B or 
pass. Only use ‘award’ when referring to the specific qualifications called awards 
(such as the Safe Road User Award). Use ‘group award’ when referring to SVQs, 
HNCs, etc. 
 
SQA has three families of qualifications: National Qualifications, Higher National 
Qualifications, and Scottish Vocational Qualifications. Always use ‘family’ to 
describe these (not ‘block’, for instance). 
 
Mentions of SQA Advanced Qualifications, SQA Advanced Diploma, SQA 
Advanced Certificate must always include the ‘SQA’ at the beginning. This is a 
legal requirement, to protect our intellectual property. 
 
If you are giving a qualification a number as well as a name, give the number 
first, then the title and use initial capitals (title case), as in this example: 
 
(DR30 35) Audio Electronics 2 
 
When referring to Next Generation Higher National Qualifications in a document, 
you should use: 
 

Title 
Next Generation Higher National 

First text instance 
Next Generation: HN (NextGen: HN) 

All other instances 
NextGen: HN 
 

Capitals in the name of a qualification 
Use initial capitals for the names of qualifications, but don’t capitalise words like 
‘and’ or ‘for’. 
 
♦ National Qualifications 
♦ National Progression Awards 
♦ National Certificates 
♦ National 4 and National 5 
♦ Higher 
♦ Advanced Higher 
♦ Higher National Diploma 
♦ Higher National Certificate 
♦ Higher National Qualifications 
♦ Scottish Vocational Qualifications 
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♦ Skills for Work 
♦ SQA Advanced Qualifications 
♦ SQA Advanced Certificate 
♦ SQA Advanced Diploma 
♦ National Courses 
♦ National Units 
♦ Higher National Unit 
♦ Higher National Group Award 
 
Also, capitalise ‘Unit’ and ‘Graded Unit’ if they appear in the unit name as 
indicated on APS, for example ‘Audio Visual Technology: Graded Unit 1’. 
 

Level of a qualification 
When you’re talking about the level of a qualification — whether it’s the SQA level 
or its level in the SCQF — the word ‘level’ doesn’t need a capital (unless it’s at 
the beginning of a sentence, of course). 
 
We now describe all our qualifications by giving their SCQF level. 
 
Since September 2016, names of SVQs (if they have an SCQF level) have 
followed the following convention: 
 
SVQ <name> at SCQF level <x> 
 
For example: 
 
SVQ Activity Leadership at SCQF level 5 
 

Grades 
We use ‘grade’ with a lower case ‘g’ to mean the level of award made to a 
candidate. 
 
Where qualifications have numeric levels, or can be awarded at numeric grades, 
always give these in Arabic numerals (1, 2, 3,…), not roman (I, II, III,…). 
Grades at Higher and Advanced Higher are given letters. These are always 
written as capitals, for example A, B, C. 
[Back] 
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Repetition 
Repetition is a problem in two ways: 
 
Redundancy: we have a tendency to try to tell our readers the whole story all the 
time. We will, for instance, tell them about verification, which makes us feel we 
have to tell them about the whole quality assurance system. This in turn makes 
us want to explain the approval criteria, even if we have already done so. If 
you’ve explained internal verification once, there’s no need to explain it again — 
use a cross-reference. 
 
Stylistically: a simple style check you can do before handing over your finished 
copy is to read over what you have written to see whether there are certain 
phrases or words you have overused. Just looking at a printed page often helps 
you see at a glance whether there’s anything obvious you’ve repeated. 
 
If, for instance, you’ve started four consecutive sentences with ‘SQA’, the text 
would read better if you changed at least two of these. 
 
Similarly, if you’re presenting a list of options that are expressed in similar 
language, try to vary them. If bullet points start with the same word or phrase, 
move this back into the stem (behind the colon introducing the list). 
 

Do say… Don’t say… 

‘In addition, many people have found 
that the new qualifications are: 
1. great 
2. brilliant 
3. flexible 
4. very good indeed’ 

‘In addition, many people have found 
that: 
1. the new qualifications are great 
2. the new qualifications are brilliant 
3. the new qualifications are flexible 
4. the new qualifications are very 

good indeed’ 
 
[Back] 
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Should and must 
‘Should’ means a recommendation, or a piece of advice. ‘You should listen to 
what this guide is saying’ is not an order, but a way of urging you to take note. 
‘Must’, on the other hand, means compulsion, and the lack of alternatives, as in 
‘you must signal your intention to pull out before manoeuvring away from the 
kerb’. 
 
You must not be afraid of using ‘must’, if it is appropriate to do so. If, for instance, 
people in centres have to submit results using a certain form, tell them so. ‘You 
must use form 1 for submitting results.’ Don’t feel that you have to use ‘should’, 
simply because it seems politer — it could cause confusion. 
[Back] 
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Spelling checklist 
This is an alphabetical list of words we use a lot, and some special features they 
have — it may be that they’re often misspelled, or that they can be confused with 
something very similar. 
 
See SQA’s Guide to Using Capital Letters on SharePoint for rules about when we 
should and should not use an initial capital. 
 

Write the word like this … … and note that it’s 

adviser  not advisor (though some SVQ standards-setting 
bodies use the -or spelling) 

back up or backup two words for use as a verb; one word for a noun or 
adjective 

benefit benefiting, benefited (don’t double the ‘t’) 
cafe not café (in British English) 
centre-devised always hyphened 
closed-book hyphened when you’re talking about a kind of 

assessment (another kind is open-book) 
competence not ‘competency’; competences in the plural (not 

competencies) 
conducive  not condusive 
consensus not concensus 
consortium-developed always hyphened, and never ‘consortia-developed’  
convener (ends in ‘-er’) for someone chairing an SQA 

meeting, but some local authorities use ‘convenor’ 
for council leader 

co-ordinator always hyphened 
criteria the plural of ‘criterion’ 
cross-marking always hyphened 
Curriculum for Excellence without an ‘a’ or ‘the’ prefix, and should be written 

out in full in formal documents (not ‘CfE’) 
despatch not dispatch 
e-assessment ‘E-assessment’ at the start of a sentence 
e-business ‘E-business’ at the start of a sentence 
e-commerce ‘E-commerce’ at the start of a sentence 
flyer not flier 
email no longer ‘e-mail’ — use ‘Email’ at the start of a 

sentence 
end-user hyphened 
enrol enrolling, enrolled, enrolment (but use ‘entry’ for 

candidates) 
feedback not feed back, except where you’re using ‘feed 

back’ as a verb 
focus focusing, focused (don’t double the ‘s’) 
forum forums in the plural, except when talking about 

Roman architectural features, when you can use 
fora 

https://sqanow.sharepoint.com/sites/connections/Publishing%20and%20writing/Documents/SQA_Guide_to_Using_Capital_Letters.pdf
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Write the word like this … … and note that it’s 

Gàidhlig Gaelic for Gaelic — use Alt 0224 on your 
keyboard’s number pad to get the à (Num Lock 
must be on) 

helpdesk all one word 
internally-assessed hyphened when it comes before ‘units’, for example 

‘internally-assessed units’; not hyphened when it 
comes after a verb, for example ‘these units are 
internally assessed’ 

licence with a ‘c’ for the noun, for example ‘driving licence’, 
but with an ‘s’ for the verb, for example ‘licensing 
laws’ 

logbook not log book 
log in, login ‘log in’ is a verb (log in to the system) and isn’t 

hyphened; ‘login’ is a noun ‘don’t share your login’ 
meta-skills always hyphened 
nationally-recognised always hyphened 
NextGen: HN not HN NextGen 
ongoing not hyphened 
online one word, no hyphen — ‘offline’ should be written 

the same way 
per cent not ‘percent’ 
phone  not necessary to write ’phone  
practice with a ‘c’ for the noun, for example ‘piano practice’, 

but with an ‘s’ for the verb, for example ‘practising 
the piano’ 

pro forma two words, no hyphen — or can you just use ‘form’ 
instead? 

re-assessment lower case 
re-sit not resit 
SQA co-ordinator lower case, except when the title of a particular 

individual 
standards-setting body all lower case, and hyphened 
subject-specific always hyphened 
target targeting, targeted (don’t double the ‘t’) 
timescale one word, no hyphen  
up to date without hyphens except when preceding a noun, for 

example ‘the qualification is up to date’, but ‘the up-
to-date qualification’ 

web page two words 
website one word, no hyphen 
wifi but Wi-Fi in technical contexts 
word-process always hyphened 
work-based always hyphened 
www.sqa.org.uk  our URL (website address) — always hyperlink; if 

it’s at the end of a sentence, put the full stop in 
[Back]  

http://www.sqa.org.uk/
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Templates 
SQA’s standard Word template is called ‘SQA Normal’. We recommend that you 
use it for most types of document other than letters. You can find it on the 
network at \\sqa3-hanover\Templates 
 
The folders contain standard templates for particular teams. The folder called 
‘General’ has various letter templates. 
 
The SQA Normal template is at the foot of the window.  
 
To attach a Word document to SQA Normal, go to the Developer tab then 
Document Template. 
 

 
 
You should see this dialog box: 
 

 
 
Select Attach then browse to \\sqa3-hanover\Templates. Select SQA Normal and 
then Open. 

file://sqa3-hanover/Templates
file://sqa3-hanover/Templates
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Select ‘Automatically update document styles’ then OK. Save your document. It is 
now attached to SQA Normal and any text or heading styles that were set up in 
the original document should have changed to those used by SQA Normal (see 
SQA Normal styles below). 
 

Important! 
Before doing anything else, you should retrace the path to the last dialog box and 
untick the option to ‘Automatically update document styles’. If you don’t do this 
and you pass the document to someone else, then the document may update 
styles again to the default template on your colleague’s machine. 
 

SQA Normal styles 
In the ribbon, select the small downward-pointing arrow at the bottom right-hand 
corner of Styles. 
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This opens the Styles pane, which includes all our standard heading styles. 
 

 
 
To apply a heading style, key in your heading text then select the text. Next, go to 
the Styles pane and click on the heading you need: 
 
♦ Heading 1 is 24 pt Arial bold 
♦ Heading 2 is 18 pt Arial bold 
♦ Heading 3 is 14 pt Arial bold 
♦ Heading 4 is 12 pt Arial bold 
♦ Heading 5 is 11 pt Arial bold 
 
If you need a bulleted list, select the list then click on ‘bullet’ in the Styles pane. 
 

 
 
Using heading styles in this way makes your document more accessible — 
screen readers can identify the various heading levels so blind users can 
understand the structure of your document. 
Heading styles applied in this way also enable you to automatically create a 
contents page. Go to the References menu and look under the Table of 
Contents tab. 
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Nested headings 
Accessibility guidelines say that your first heading in a sequence should be a 
heading 1 and that all the following subheadings should follow consecutively: H2, 
H3, H4, H5. The headings are then said to be ‘nested’. 
 
There may be times, however, when you have a good reason not to follow an H1 
with an H2 or an H2 with an H3. Two instances of this are when: 
 
♦ you don’t want a heading to appear in a Word-generated contents list 
♦ you have a heading for specific content that appears in different sections of 

your document and sometimes the heading for the specific content falls after, 
say, an H1 and sometimes after an H2 — but you think it would be most 
helpful for the reader to see the same level of heading for this content as they 
move from section to section through the document 

 
Both these examples will fail the nested-headings test in an accessibility checker, 
which will then deem your document as non-compliant with equalities legislation 
and so SQA could, possibly, face an unlimited fine. 
  
At the time of writing (March 2022), we are seeking advice on this point, but in the 
meantime we will treat the above instances as exceptions as long as headings 
otherwise follow a logical order.  
 

Forcing nested headings 
If you are working on a document that starts with, say, an H2. You can change it 
to an H1 by selecting the dropdown arrow on the H2 style in the Styles pane, 
choosing ‘Select all instances’, and then applying the H1 style to all the 
instances. Next, go to the dropdown menu to the right of the H1 style and select 
‘Modify’. Then adjust the font size to match the size of the original heading (18pt 
if it was an H2). You then should repeat this process for all the other heading 
levels in your document. 
  
Note: If you want to preserve the ‘look’ of your original document exactly you may 
have to adjust the ‘Before’ and ‘After spacing under Modify > Format > 
Paragraph. 
[Back]  
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That or which? 
This is a source of confusion, and there’s no hard and fast rule. It helps your 
reader, though, if you use ‘that’ to introduce a defining clause: 
 
‘The dogs that barked in the night did not recognise the thief.’ 
 
And use ‘which’ to introduce a describing clause: 
 
‘The dogs, which barked in the night, did not recognise the thief.’ 
 
In the first example, ‘The dogs that barked’ suggests there were other dogs that 
did not bark. In the second, we can be more confident that all the dogs barked 
(and the comma between ‘dogs’ and ‘which’ helps). If you use ‘that’ and ‘which’ in 
this way you can help your reader work out whether or not all the dogs barked. 
 
A good rule of thumb is that, if you’re in any doubt about whether to use ‘that’ or 
‘which’, you should use ‘that’. However, when writing about a person or people, 
you should always use ‘who’ or ‘whom’. 
[Back] 
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Titles of people involved with qualifications 
Positions or roles of SQA employees and appointees are set in title case when 
referring to individuals. But use lower case when referring to positions or roles in 
general. Here are some examples: 
 
‘Sam Smith, Qualifications Manager, was recently appointed to the …’ 
but 
‘SQA qualifications officers are responsible to a qualifications manager.’ 
Or 
‘Fiona Robertson, SQA’s Chief Executive, recently attended ...’ 
but 
‘The Scottish Government invited the chief executive to attend …’ 
 
‘Overall, external verifiers found that the centres sampled had a clear 
understanding of the requirements for …’ 
 
‘A nominee represents their school/college and local authority (where 
appropriate) in assisting SQA with the maintenance of national standards of the 
qualifications within their subject area.’ 
 

Referring to the people who take our qualifications 
The people who are taking our qualifications are ‘candidates’, but only when 
they’re taking the qualifications, for example in the exam hall, or being assessed 
in their workplaces. You’ll use the word ‘candidate’ most often when you’re 
talking about assessment or certification. 
 
At all other times, you can refer to these people as ‘learners’ if they are at school 
or college and ‘trainees’ if they’re doing workplace training. ‘Students’ is a 
suitable alternative for learners at college. It’s also fine to talk about more specific 
roles (for example apprentices, trainee hairdressers, fitters) if your document is 
very specific. 
 

The process of entering candidates for qualifications 
Candidates are ‘registered’ only once and are subsequently ‘entered’ for 
‘qualifications’. Usually, they will go on to receive an ‘award’ in a qualification. 
SQA ‘charges’ centres for entries. We pay ‘fees’ to appointees. 
 
The places (schools, colleges, workplaces, etc) where candidates do the 
qualifications are called ‘centres’. We no longer use the term ‘presenting centres’. 
[Back]  
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Tone 
Tone is about how we ‘sound’ to our readers. It is important because if a reader 
finds your tone to be too arrogant, condescending or pedantic then they might not 
value or act on what you are saying. 
 
You might think that you have expressed your ideas well, but try to remember 
that you are not writing for yourself. Try to invoke the idea of ‘walking in the shoes 
of your audience’ — it can be a very helpful approach to find the right way to say 
something. 
 
We want all our audiences to think of SQA writing as clear, confident and 
approachable — and, depending on what they are reading, possibly also 
inspiring. 
 

Be clear 
We want our readers to grasp what we are saying quickly and easily. You can do 
this by using: 
 
♦ short words 
♦ short sentences 
♦ short paragraphs 
♦ the active voice 

 

Do say this … Don’t say this … 

‘Ask learners to explain 
their solution in their own 
words.’ 

‘The learner should be required to give 
meaning to the determined solution in 
everyday language.’ 

‘Candidates do not always 
complete the task.’ 

‘Issues of candidate task completion are 
being experienced.’ 

 
As a guideline: if it’s something you wouldn’t consider saying in speech, then 
don’t write it down. 
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Be confident 
Writing that is formal and detached and that favours the passive voice can 
sometimes be seen as over-cautious or lacking confidence. 
 
SQA wants you to state your position with certainty and assurance. Avoid 
unnecessary words and use practical, straightforward language to convey ideas. 
Readers are less likely to be confused. 
 

♦ Get straight to the point. 
♦ Be direct. 
♦ Say what you mean without too many conditions. 
♦ Use words your readers would use. 
♦ Use technical language in context but avoid jargon, abbreviations and 

acronyms. 
♦ Check facts. 
♦ Proofread for typos. 
 

Do say this… Don’t say this… 

‘Remember that you can 
only provide technical 
assistance to your 
candidates. You are not 
allowed to help with the 
content.’ 

‘It was again apparent, in some instances, 
that centres were either not aware of the 
guidance or may have misinterpreted it. 
Teachers are further reminded that the 
function of their role in dealing with the 
externally assessed assignment is purely 
one of administration and supervision.’ 
 

‘You must acknowledge all 
material from sources like 
books, TV and the internet. 
Your teacher or lecturer can 
tell you how it’s done.’ 

‘It is essential for all candidates to ensure 
that they are meticulous in referencing their 
sources. Information on the appropriate 
method to use to show references can be 
obtained from teaching staff.’ 

 

Be approachable 
Your writing needs to convey meaning to everyone who needs to act on it so that 
they then respond in the way that you intended. So avoid words or phrases that 
might confuse or even antagonise your audience and choose words and phrases 
that show you are one person communicating with another. Some SQA writing 
reads as if we are lecturing a group, but even if you are broadcasting a message 
to a wide audience it can help to write as if you are ‘talking’ to an individual. 
 
You can even use this approach for procedural documents which are written for 
people in centres who are doing the organising and administration that running 
our qualifications demands. Once you’ve made this plain in an introduction, there 
is no reason why you shouldn’t then address these people as ‘you’ throughout 
the text, rather than referring to ‘centres’. So, don’t say: ‘Centres should retain 
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candidates’ work for verification’, if it would be just as easy to say: ‘You should 
retain candidates’ work for verification’. 
 
Similarly, a lot of what we write is written for teachers and lecturers. If you’re 
writing for teachers and lecturers, say so and then address them personally — 
call them ‘you’, not ‘teachers/lecturers’. They may pay more attention to what you 
have to say, and will find it easier to understand. 
 
♦ Think about who will read your writing. 

— Why are they reading it? 
— What task are they trying to complete? 
— What information will help them? 
— What order should it go in? 

♦ Follow accessibility guidance. 
♦ Be inclusive. 
♦ Use ‘you’ and ‘we’. 
♦ Be positive rather than negative. 
♦ Ask the reader questions. 
♦ Use contractions — we’re, can’t. 
 

Do say this… Don’t say this… 

‘You should keep all 
candidate work for 
verification.’ 

‘Centres should retain candidates’ work for 
verification.’ 

‘So, exam day has finally 
arrived and you've 
prepared for it as much as 
you can. Here are some 
tips to help you do the best 
you can.’ 

‘SQA has gathered relevant information 
together to assist candidates at the point of 
sitting exams.’ 

 

Further reading 
The Tone of Voice module of the Clear and Confident Writing course on SQA 
Academy. 
 
MailChimp is an email service provider that helps marketing departments send 
bulk emails to clients, customers, and other interested parties. You may find 
MailChimp’s guidance on voice and tone useful: 
 
http://voiceandtone.com/ 
[Back] 

  

https://www.sqaacademy.org.uk/course/view.php?id=703
https://www.sqaacademy.org.uk/course/view.php?id=703
http://voiceandtone.com/
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Web pages 
People don’t read text on a website in the way that they read printed material. 
They scan, rather than scrutinise. They pick out headings and key words, rather 
than read everything chronologically and line-by-line. They also tend to spend 
less time reading online than they would reading print. 
 
Also, because of the nature of the internet, the order in which we present 
information on the site may not be the same order in which it is read by the user. 
They may jump to a specific location within the site from a link or search result, 
and so not have the background knowledge of the preceding pages. 
 
So when producing information for online publication, the first thing you need to 
ask is: what is the most appropriate way to display your information? Would it be 
better for the reader if it was: 
 
♦ a single web page or series of web pages forming a section of the website 
♦ a separate stand-alone website 
♦ an interactive application 
♦ a file that users can download or print and read at their leisure? 

 

General tips and best practice 
All web pages should be self-contained and self-explanatory. If a reader lands on 
a page with no knowledge of the preceding pages, they should still be able to 
make sense of the information provided. 
 
♦ Use plain English and keep specialised terminology to a minimum. If 

someone has to reread a sentence or phrase to clarify the meaning, then the 
text is not fit for purpose. 

♦ Use headings and subheadings that provide information to your reader. 
♦ Aim to have one key idea in each paragraph. Structure paragraphs so that 

the conclusion or key idea is in the first sentence and then provide more 
detail in the sentences that follow. 

♦ Keep text to a minimum. 
♦ Use bulleted lists to break up the information so that readers can easily find 

what they are looking for. 
♦ Introduce information appropriately and use titles that explain the context. It’s 

not enough to provide a link or document title, for example ‘SQA workshop 
presentation’ — as it could be referring to any workshop that has been held 
by SQA. 

♦ Don’t repeat information on a web page — provide a link to the initial source. 
 
[Back]  
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Wikipedia 
Wikipedia is a popular source partly because the content is free to use — but 
there are conditions that need to be adhered to. See: 
 
https://en.wikipedia.org/wiki/Wikipedia:Copyrights#Reusers.27_rights_and_obliga
tions 
[Back] 
  

https://en.wikipedia.org/wiki/Wikipedia:Copyrights%23Reusers.27_rights_and_obligations
https://en.wikipedia.org/wiki/Wikipedia:Copyrights%23Reusers.27_rights_and_obligations
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Word — readability statistics 
Flesch readability statistics are based on the average sentence length, the 
number of difficult words, the number of passive sentences, and paragraph 
length. 
 
You can take your checking a bit further with a little application that will tell you 
how readable your writing is. Go to File > Options > Proofing and make sure that 
the ‘Show readability statistics’ option is ticked. 
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Then the next time you run the spellchecker, a window like the following will 
appear: 
 

 
 
You can ignore the Flesch-Kincaid Grade Level, which is based on the reading 
ages attained in US school grades. The important figure is above this. The higher 
the figure (it’s a percentage), the better. You should be aiming for 40 and over for 
an audience of teachers, 50 and over for the general public, and 60 or over for 
learners. If your score is low, you can use the information under ‘Averages’ to 
improve it. 
[Back] 
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Word — spellcheck 
Always use the spellchecker, though you’ll have to decide whether the 
suggestion offered is indeed correct. Remember we use ‘organise’ not ‘organize’. 
Before you use the spellchecker, please make sure that your document’s 
language is set as UK English (go to File > Options > Language). 
 

 
 

Caution! 
Word’s checking tools cannot catch words that are spelled correctly but which 
don’t make sense. ‘Leaner’ instead of ‘learner’ is a common slip that isn’t 
detected by a spellcheck. 
[Back] 
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Words we prefer to use 
How many words should I write? 
If there is one basic principle for writing clearly, it is this: keep it short and 
simple. This applies to words, sentences, paragraphs, chapters, and, especially, 
to documents. Say what you want to say in as few words as you can, then say no 
more — saying more tends to confuse the issue. 
 

What’s a good word to use? 
This is a difficult question to answer in detail. We can’t give you a list of words to 
choose from and say ‘don’t use any others’, because the words you use will 
depend on your subject matter, and how comprehensibly you are using them 
depends on their context. In general, though, good words are plain, simple and 
easy to understand. 
 
You have a degree of freedom to choose whether to use only short words or 
mainly short words but a few big ones, depending on your audience. If you’re 
writing for candidates with learning difficulties, for instance, the words (and 
sentences, and paragraphs) you use must be easy to read. If you’re writing for 
teachers and lecturers, you can use more complex constructions. The important 
thing is to be as direct and unambiguous as possible. Everyone would rather 
have a simple text to read than a difficult one. 
 

What’s a bad word? 
Any word is bad if people aren’t going to understand what you’re trying to say 
with it. There is, for instance, little point in using a word like ‘architectonic’ in a 
piece of writing, because no-one reading it will know what you mean. Similarly, 
it’s all very well knowing what ‘lugubrious’ means, but are you using it just to 
show off? Why not use ‘sad’ or ‘mournful’ instead? 
 
Try to avoid using big words derived from Latin (words ending in ‘-tion’, ‘-ment’ or 
‘-ise’ for instance) if you can think of a simpler way of saying what you want to 
say. So, if you can say ‘help’ instead of ‘contribution’; or ‘carry out’ rather than 
‘implement’, do so. 
 
A guideline: the more syllables there are in a word, the more reluctant you should 
be to use it. 
 

Words to think twice about before using 
Many newspapers and publishers have ‘hate lists’ of words which are so 
overused that they would appear in every single story unless the paper took 
drastic action to prevent it. A paper will ban these words from ever appearing in 
print. Read The Sunday Times and see if you can spot an occurrence of the 
words ‘major’ or ‘current’. There should be very few in this paper. ‘Very’ can also 
be used unnecessarily. 
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We are not banning the words in this list. We are saying please try not to use 
them as they are a) hugely overused, and b) often a sign of sloppy thinking or 
writing. 
 
a number of: This is a vague, woolly, and bureaucratic phrase. Don’t use it — 
say ‘some’ instead. If you absolutely must use it, remember that it takes a plural 
verb, not a singular — ‘a number of people are concerned’ not ‘a number of 
people is concerned’. 
 
‘Candidates will already have developed a number of some of the skills, 
behaviours and knowledge. 
’ 
appropriate: This word often means nothing, as in the phrase ‘SQA staff will give 
the appropriate advice and guidance’. If you say we will give people ‘appropriate 
advice’, does this mean that they sometimes get inappropriate advice from us, or 
that they think they might? Instead of using the word, either say what the 
appropriate advice might be, or miss out the word altogether. 
 
articulate: This really means ‘to say’, but is sometimes used to mean ‘to lead on 
to’, or ‘to progress’. Please use the simpler alternatives. 
 
associated: should never be used as an adjective. The phrase ‘this performance 
criterion and its associated evidence requirements’, for instance, is confusing 
because you wonder which evidence requirements for the performance criterion 
are the associated ones, and which are not. 
 
at this point in time and its cousin at this moment in time raise most people’s 
hackles. Don’t use them. 
 
implementation: We use this word to mean ‘setting up’ qualifications so that they 
can be delivered or ‘putting them into practice’ so that candidates can take them. 
Don’t use ‘implementation’ to mean teaching, training or assessment. 
 
in relation to: This crops up all the time in phrases like ‘SQA’s policy in relation 
to …’. You should always be able to replace it with ‘on’ or ‘about’, or to miss it out 
altogether. 
 
‘Self-awareness in relation to of relationships…’ 
 
indicate: can sometimes be replaced by ‘show’. 
 
inform: can almost always be replaced by ‘tell’. 
 
particular and specific: These are very widely used, but very rarely mean 
anything. If you feel a temptation to use either of them, read your sentence over 
and ask yourself what ‘particular’ means in ‘the particular candidate’. Usually you 
will be able to dispense with it altogether. The same goes for ‘specific’. This may 
seem like quibbling, but, as we’ve said before, using words which add nothing to 
the meaning of a phrase makes that phrase harder to understand. 
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relevant: One of the most overused words in our vocabulary. In a phrase like 
‘after consultation with relevant staff’, what meaning does the word add? Do 
people regularly consult with irrelevant staff? 
 
with reference to: can be replaced with ‘about’ 
 
within: means ‘inside’. Don’t use ‘within’ if you mean ‘in’. You almost always 
mean ‘in’. There is no meaningful sense in which anything can be ‘within’ a 
qualification, or ‘within’ a context. You can, though, be within a building, and 
things can happen within an organisation (if they happen exclusively inside it). 
 

General ‘think twice’ list 
This think twice list applies more generally than to our publications. It’s based on 
Plain English Campaign guidelines for, well, plain English. 
 

Try not to write: Instead, write: 

additional more 
as indicated above  as we’ve already said, or see the section 

on ...  
as itemised below here is a list 
as mentioned previously as we’ve already said 
as regards/with regard to about 
assist help 
by means of by 
capability ability 
consequently then 
consist of be made up of 
constitutes is, makes, builds up to 
effect (as verb) make, do 
facilitate help 
for the purposes of for 
function role, work, job 
further more 
have responsibility for be in charge of, deal with 
in accordance with under, following 
in addition also, as well 
in conjunction with with 
in order to to 
in relation to about, of 
legislation law, laws 
necessitate cause 
obtain get 
prior to before 
proficiency skill 
regarding about, on, to, of 
relating to about, on, to, of 
require to need to, have to 
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Try not to write: Instead, write: 

sufficient enough 
terminate end, stop, finish 
therefore so 
undertake do, try for 
until such time as until 
utilise use 
with reference to about 
within (unless you mean ‘inside’) in 

 
Going forward, we need to address the issue of clichés. Its literally not rocket 
science but a little thinking outside of the box will address the issue. 
 
Every underlined term in the previous paragraph has been nominated as a ‘most-
annoying cliché’. It is best not to use them because tired terms switch off 
attention — which leads to readers missing your message. 
 
Plain English Campaign — Clichés 
[Back] 
  

http://www.plainenglish.co.uk/campaigning/examples/cliches.html
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Writing about people 
When you’re speaking about people other than your readers (whom you should 
always address as ‘you’), speak about them in the plural. This will apply, for 
instance, when you’re speaking about candidates in a guide for teachers and 
lecturers. 
 
There are two reasons for this. If you speak about them in the singular, you will 
find yourself using phrases like ‘the candidate can progress to other 
qualifications’, which is objective and depersonalised, and makes the candidate 
sound like a thing rather than a person. Also, you will get into trouble when you’re 
using pronouns and find that you are having to say ‘he or she’ all the time. Using 
the plural gets around this because you can use the neutral ‘they’. 
 

Do say … 
‘Candidates will carry out a practical exercise to show they can accurately 
complete the registration procedures for six bookings.’ 
 

Don’t say … 
‘Each candidate will carry out a practical exercise to show he/she can accurately 
complete the registration procedures for six bookings.’ 
 
Note: it’s not wrong to use ‘they’ for a single person (for example to say ‘if a 
candidate is ill, they might be eligible for special consideration’) and it allows us to 
use language that is gender neutral. 
[Back] 
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Writing the name of the organisation 

 
If your document has our logo on it, you can refer to ‘SQA’ in the text. 
 
Elsewhere, though, give the name in full when you first use it. After this, you can 
say ‘SQA’. Don’t use ‘the Authority’, as it can be confused with ‘education 
authority’, and might be taken as pompous. 
 
When giving the name in its abbreviated form, use ‘SQA’ not ‘the SQA’. 
 

Do say … ‘You can complain to SQA if you think 
that a centre has done something 
wrong. 

’Don’t say …  ‘You can complain to the SQA if you 
think that a centre has done 
something wrong.’ 

 

Internal communications 
If you need to refer to the offices in Dalkeith and Glasgow, use ‘SQA Lowden’ 
and ‘SQA Optima’. 
[Back] 
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